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Chapter 1 

Getting Started with File-it! 
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Before You Begin 

How to Use This Manual 
The best wav to become familiar with File-it! is to 
use it. Read the text and work through the 
examples on your ternlinal. If you press the 
wrong key or get lost, don't worry. You can 
always ask File-it! for help any time you want 
more information about what to do next, how to 
leave a section of the program, or how to start 
over again. 

Each chapter in this manual concentrates on one 
section of File-it!. The appendixes give 
supplementary technical information. The index 
can help you find particular parts of File-it! quickly 
and easily. 

Specifying a Terminal 
If you are using a UNIX-based operating system, 
you need to know the termcap name of your 
terminal before vou start to work with File-it!. See 
Appendix F for ~ietails. 

The Control Keys 
The letter and numeric keys of a computer 
keyboard are arranged like the keys of a 
typewriter. However, some keys have special 
uses, such as moving the cursor (the small lighted 
rectangle or underscore on the terminal screen 
that indicates where the next character is going to 
appear), initiating commands, and canceling 
commands. Before vou s tart to use File-it!, find 
the keys listed belo~ on your keyboard. 

• The RETURN key is sometimes labeled CR, or 
NEWLINE, or is sometimes labeled with a bent 
arrow. 
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Compatibility 
File-it! is compatible with Relational Database 
System's INFORMIX Database Management 
System. As your needs for information handling 

. grow, you will not need to learn a new system. 
You will find that the files you built using File-it! 
are immediately usable from INFORMIX. 

INFORMIX offers all of the features of File-it!, plus 
powerful report writers, screen builders, and 
language tools. 

See Appendix 0 for information on using File-it! 
files withINFORMIX and INFORMIX files with 
File-it!. 

What Is a Database? 

A database is a collection of information (data). 
An example of a database is your personal phone 
book which contains the names, addresses, and 
telephone numbers of your friends or business 
associates. Other kinds of databases include: 

• Mailing lis ts 
• Parts lists 
• Client lists 
• Inventory lists 
• Catalogs of records, stamps, and books 

Whatever information vou work with, File-it! 
enables you to store it so that you have access to it 
quickly, easily, and in a form that is useful to you. 



Querying a Database 

Once there is data in a File-it! database, you can 
ask File-it! questions about the data. This process 
is called querying the database. The following are 
typical queries for several different kinds of 
databases: 

A Parts List Database 
List all parts that cost more than $100 
List all parts that are back-ordered 
List all parts that are back-ordered and 

cos t more than $100 
List all parts with the word "gasket" in 

their descriptions 
List all parts that are back-ordered, cost 

more than $100, and have the word "gasket" 
in their descriptions 

A Book Database 
List all books published by XYZ Press 
List all books written by Mary Jones 
List all oversized books that cost under $25 
List all books with the word ilflower" in 

their descriptions 

An Employee Database 
List all employees who have been with the 

company for more than ten years 
List all employees who have no sick leave left 
List all employees who have over three weeks 

vacation due and earn over $15,000 a year 

File-it! can give you only the information that you 
have stored in your database-it cannot 
manufacture data. It cannot retrieve someone's 
phone number if you never entered the number 
into your database. 

File-it!' s power COlnes from its ability to retrieve 
your data from your database and to allow you to 
look at it in many different ways, depending on 
your needs and the queries you make. 
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Using the Help Menu 
Every File-it! screen has a Help text associated with 
it. Whenever you want information about what to 
do next, simply hold down the CONTROL key and 
press W, and File-it! displays the Help text. 

The Help text has a menu (shown below). The 
menu lets you read as much or as little of the text 
as you want. 

HELP: ~ Resume 
Displays the next page of Help text. 

The Screen option displays the next page of the 
Help text; the Resume option lets you continue 
your work. 

Use the Help menu like any other File-it! menu. 
Move the highlight by pressing the SPACE bar. 
When it is on the option you want, press RETURN. 

You can also just enter the first letter of the option 
you want. 

Using the File-it! Form 

When you work with the information in your 
File-if! database, you will use a form on your 
terminal screen. An example of a form is shown 
below. 

DATA: ~ Next Previous Add Update Remove Screen Output Exi t 
Searches the act ive database file. 

----- Page 1 of 1 ----- names ------------------ Press CONTROL4N for Help ----

fir s t _name I 
last_name I 
addressl I 

'address2 I 
city I 
state I I 
zip I 
phone I 

The form is like a paper form with places for you 
to fill in words and numbers. The default form 
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DATABASE > .. {] 
Choose database wi th ARROW keys or enter new database name. Press RETURN. 

------------------------------------------------ Press CONTROL4N for Help ----

The following databases are available. 

2: Select the names da tabase by using the ARROW 

keys to move the highligh t to the word names. 
(If you are using File-it! for the first time, names 
will be the on Iv selection-there will be no 
need to move the highligh t.) Press RETURN to 
complete your selection. 

- File-it! will display the Top-level menu with the 
name of the da tabase vou selected on the 
fourth line of the screen. 

TOP-LEVEL: [DiIiJ Schema-design Form-design Report-design Utility Bye 
Queries the database. adds. removes. and updates records. 

----------------------- names ------------------ Press CONTROL4N for Help ----

Querying the Names Database 
The following example shows how to look up 
Terrv Green in the names database. After vou 
have added some more names and addresses to 
the names database (see Example 1-3), you can use 
the same procedure to look up those names. 
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3: Move the cursor to the last_name line with the 
RETURN key. If you move the cursor to a line 
below the last_name line, press RETURN several 
more times; it will cycle back to the last_name 
line. 

~ File-it! moves the cursor to the next line in the 
form each time you press RETURN. After this 
step, the cursor will be positioned as shown 
below. 

QUERY: ESCAPE queries. DEL discards query. ARRON keys move cursor. 
Searches the act ive database file. 

Field: last_name Type: character 
----- Page 1 of 1 ----- names ------------------ Press CONTROL~ for Help ----

first_name 
last_name 
addressl 
address2 
city 
state 
zip 
phone 

4: 
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Enter Terry's last name (Green), making sure 
that you use an uppercase G and lowercase 
reen. 

- File-it! displays the letters between the brackets 
([D on the last_name line as you enter Green. 
If you press the left ARROW or BACKSPACE key, 
the cursor will move to the left so tha t vou can 
correct a mistake. When you are finished 
entering the name, the screen should appear as 
shown below. 

QUERY: ESCAPE queries. DEL discards query. ARROW keys move cursor. 
Searches the act ive database file. 

Field: last_name Tvpe' character 
----- Page 1 of 1 ----- names ------------------ Press CONTROL-W for Help ----

fi rst_name 
last_name 
addressl 
address2 
city 
state 
zip 
phone 

( 
(GreenO 
( 
( 
( 
( 
( 
( 
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Adding Data to the Names Database 
Example 1-3 shows you how to add names, 
addresses, and phone numbers to the names 
database. Once you have added information on 
some more people to the database, you can use it 
as your personal phone book. 

Example 1-3 

This example adds information about a person to 
the names database. It starts with the Data menu 
at the top of the screen, just where Example 1-2 
left off. 

The following name, address, and phone number 
are used in this exam p Ie . You can use this 
fictitious person or use someone you know. Be 
sure to use consistent capitalization for the name 
and address. 

Sample data to be added: 

Martha Howard 
1234 Broad wav 
New York, NY 10023 
212/936-1212 

1: Select the Add option from the Data menu. 
You can make this selection by using the SPACE 

bar to move the highlight to the Add option or 
by pressing the a key. 

- File-it! moves the cursor to the first line in the 
names form. This is the first_name line. If 
there was information on the form, File-it! 
clears it from the screen so vou can en ter ne\\T 
information. .; 
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ADD: ESCAPE adds new data. DEL discards i I. ARROW keys move cursor. 
Adds new data to the act ive database file. 

Field: phone Type: character 
----- Page 1 of 1 ----- names ------------------ Press CONTROL4N for Help ----

first_name 
last_name 
address1 
address2 

[Mar tha 
[Howard 
[1234 Broadway 
[ 

c i Iy 
stale 
zip 
phone 

4: 

[New York 
[NY] 
[10023 ] 
[212! 936 - 1 212m 

Press ESCAPE to enter the data into the database. 

- File-it! displays the Data menu with the 
message Record added at the bottom of the 
screen. 

Martha Howard is now in the names database. 
You can look up her address and phone number 
just as you did Terry Green's in Example 1-2. It is 
that easy. Add more names and experiment with 
the names database until you are comfortable 
using File-it!. 

Leaving File-it! 

When you have finished working with the names 
database and want to leave File-it!, select the Exit 
option from the Data menu. File-it! will display 
the Top-level menu. Select the Bye option. You 
will leave File-it! and return to the operating 
system. To call File-it! again, follow the method 
described in Example 1-1. 

The next four chapters in the manual describe how 
to set up a new database, add data to a database, 
perform queries, and modify the form. Chapter 6 
explains designing a report, and Chapter 7 
discusses advanced features. 
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Chapter 2 

Setting Up a Database 
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File-it! knows nothing about the information you 
will be storing in your database until you tell it 
about your data. In order to set up your own 
database, you must tell File-it!: 

• The kind of da ta you are going to keep in the 
database 

• How you are going to organize the data 

This chapter describes how to select a new 
database name and define the database in terms of 
the information you want to store in it. It covers 
four types of data Y9u can store in a File-it! 
database, telling why you would use each, and 
explains how to use the Schema-design menu to 
set up a database. 

Five concepts are key to setting up a database: 

• Database names 
• Fields 
• Records 
• Types of data 
• Indexes 

Selecting a Database Name 

The first thing File-it! needs to know is the name 
of the database. You can choose anv name vou 
like, but it is a good idea to make it "'meaningful. 
Names contain between one and ten characters, 
and they must begin with a letter. After the first 
letter, you may use letters, digits, and underscores 
for the rest of the name. File-it! will not allow vou 
to enter more than ten characters. Names cannot 
contain SPACES. If you choose a name that begins 
with a number or a punctuation mark, File-it! will 
ask you to choose another name. 
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Types of Data 

You can store many different types of data in a 
database: dates, zip codes, names, part numbers, 
part descriptions, costs-the list is endless. You 
will need to choose the description which best 
suits each piece of your data. Alphabetic data is 
always stored in character fields. Numeric data 
can be stored in one of eight kinds of fields: 
integer, long, serial, float, money, date, edate, or 
ydate. The more commonly used data types, 
character, integer, money, and date, are described 
in the following sections. For details on the other 
data types, see Appendix A. 

Numbers are characters. It is possible to store all 
of your data as characters, even the numbers. But 
if you do not tell File-it! that a field, such as 
someone's age, is numeric, it may not be able to 
give you the list you want (for example, all the 
people between the ages of 7 and 13). For the 
salne reason, dates should be stored as dates and 
money should be stored as money. 

Characters are not numbers. If a field contains 
any letters or punctuation (except for period, plus 
sign, and minus sign in numeric fields, slash, 
period, and SPACE in date fields, and period, plus 
sign, minus sign, and dollar sign in money fields) 
it must be a character field. If you will need to 
look at the field as a number, try to separate the 
number portion of the field and put it in its own 
field. For example, you can group state and zip 
code together, or you can make them two separate 
fields. 

The maximunl size record that File-it! can store is 
2048 characters (bytes)-the equivalent of half a 
page of single-spaced, typed text. A record can be 
composed of many fields, but the total size of all 
the fields combined must not exceed the 
maximum record size. Appendix A lists the size 
of each type of field. 
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Date value Meaning 
06/21/63 June 21, 1963 
09/08/83 September 8, 1983 
12/25/09 December 25, 1909 

Using Indexes 

Making It Easy to Find Information 
File-it! uses indexes to help it find information 
more quickly. Just as you can find information in 
a book without looking in the index, File-it! can 
find information without the use of an index-an 
index just speeds things up. 

Indexes are associated with fields. A telephone 
directory is indexed by last names ("records" in a 
phone book are stored according to each person's 
last name). You can index your phone book 
database by last name (if it has a last name field), 
zip code, city, or by allY field in the database. 
Most important, File-it! allows you to have as 
many indexes as you need. 

If you are just getting started with File-it! and 
have a small database, vou do not need to concern 
yourself with indexes; File-it! will work fine 
without them. As your database grows, you can 
always add an index. 

Allowing Duplicates in an Index Field 
File-it! normally allows you to have as many 
records as you like with the same value in an 
index field (for example, you can have as many 
Smiths in your database as is appropriate). In 
some cases you may want to make sure that you 
do not have more than one record with the same 
entry in a certain index field. As an example, you 
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DATABASE-·c h k boo kO 
Choose database with ARROW keys or enter new database name. Press RETURN. 

---------------------------------------- -- -------- Press CONTROL-W for He I p ----

The following databases are avai lable' 

2: Press RETURN. 

- File-it! creates the new database and displays 
the Top-level menu with the name of the new 
database on the fourth line. 

TOP-LEVEL: ~ Schema-design Form-design Report-design Ut iii ty Bye 
Queries the database: add~. removes. and updates records. 

----------------------- chkbook ---------------- Press CONTROL-W for Help ----

After you use the options in the Schema-design 
menu to build the chkbook database, you can 
select chkbook from the list of database names that 
File-it! displays when you first load it, just as you 
selected the names database in Example 1-1. 

The next step in setting up the chkbook database 
is to tell File-it! about the data you will be storing 
in it. You communicate this information to File-it! 
with the schema (set of specifications) for the 
database. 

Specifying the Schema 
When you establish the specifications for a 
database, vou define the database in terms of a 
schema that tells File-it! how vou want to store 
your data. You must tell File~it! the following 
information about each field: 

• The name of the field 
• The type of da ta you \vill s tore in the field 
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Using the Schema-design Menu 
The Schema-design menu offers five options: Add, 
Change, Remove, Screen, and Exit. When you 
select Exit, you have two choices: Build-new­
schema and Keep-old-schema. The first 
implements the schema as you have defined it and 
then displays the Form-design menu. The second 
returns you to the Top-level menu without 
implelnenting anything you have done since 
selecting the Schema-design menu. Add is 
described in the following section; the Change and 
Remove options are covered later in this chapter. 

When File-it! displays the Schema-design menu at 
the top of the screen, it displays the schema for the 
database on the rest of the screen. The schema is a 
table that defines a record. Each row in the 
scheme) table represents a field, with the name of 
the field at the left. Each of the five columns in the 
schema table presents some information about the 
field, such as the type of data that will be stored in 
the field. After you have finished building a 
schema table for the chkbook database as shown 
in Example 2-3, the screen will appear as follows. 

SCHEMA·DESIGN: ~ Change Remove Screen Exit 
Adds fields to the database schema above the line with the highlight. 

Record size: 95 
----- Page 1 of 1 ---~- chkbook -~-------------- Press CONTROL4N for Help ----

Data Field Name Type Length Index Dupl icates 

checknum 
ddate 
payee 
amount 
notes 
tax ded 
r== 

Integer 2 Index No 
Date 4 Index Yes 
Character 40 
Money 6 
Character 40 
Character 1 

~ 

Using the Add Option 
You will be using the Add option of the Schema­
design menu to establish the schema table for the 
chkbook database. Once you select the Add 
option, File-it! allows you to define each field in 
the database, one at a time. As vou define each 
field, File-it! prompts you for the information it 
needs. Most of the questions File-it! asks are in the 
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Example 2-3 

This procedure adds the check number field to the 
chkbook database schenla table. 

1: After selecting the Schema-design menu 
(Exanlple 2-2), select the Add option. 

- File-it! asks you for the name of the field you 
are adding. The highlight on the schema table 
(on the lower portion of the screen) shows you 
\-vhere FJle-it! will place the name of the field 
after you en ter it. 

ADD NAME·-'[] 
Enter field name. RETURN adds It. DEL returns to Schema-design menu. 

Record size: 0 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL~ for Help ----

Data Field Name 
c=~ ______________ ~ Type Length Index Duplicales 

2: Enter the nalue of the field (checknum). 

- File-it! displays the field nalue at the top of the 
screen as you enter it. The highlight in the 
schema table indicates the 3D-character 
maximunl length of a field name. You can use 
the BACKSPACE or left ARROW key to back up and 
correc t any luis takes you make. 

3: Press RETURN to tell File-it! that you have 
finished entering the field name. 

- File-it! moves the field name from the top line 
of the screen to its proper position in the 
schema table, moves the highlight to the Type 
column, and displays the Add Type menu at 
the top of the screen. 

4: Press i (integer) to select the data type you 
want to store in this field. You can also use the 
SPACE bar to move the highlight to the desired 
data type and then press RETURN. 
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ADD NAME ;...XJ 
Enter field name. RETURN adds it. DEL returns to Schema-design menu. 

Record size: 2 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL~ for Help ----

Data Field Name Type Length Index Dupl icates 

checknum r== Integer 2 Index No 

To add the other fields, follow the same steps that 
were detailed in Example 2-3. Below is a list of the 
questions that File-it! will ask about each of the 
fields and an appropriate response for each 
question. 

ddate field. 
Data Field Name 

Type 
Index 
Duplicates 

payee field. 
Data Field Name 
Type 
Length 
Index 

ddate 
(You cannot use the word 
date as the name of the field 
because it has a special 
meaning to File-it!. See 
Appendix B, "Reserved 
Words," for more 
information.) 
date 
yes 
yes 

payee 
character 
40 
no 
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Changing the Database Specifications 

(Jnce you set up the schenld for a database-even 
(.)Her you have put data into the database- File-it! 
allows you to chdnge the way you store your data. 
OCG)siondlly, 111dking 11 change of this kind 111ay 
have the side effect of losing SOlne of your data. 
File-it! \vill alwl1vs advise vou of this situation and 
give you the option of nof 11ldking the change. An 
exalnple of d change that could Cduse i1 loss of data 
is changing a ch(.)racter field fronl a length of 20 to 
10. File-it! \voldd drop (truncate) the last ten 
characters of this field in each data record in the 
database. 

'[\\'0 options in the Schellla-design menu allo\v 
~/ou to change d scheml.): Change and Relnove. 
Change allovvs you to Inl.)ke selected changes to 
pl)rts of a field, \vhile Renlove deletes the 
specificdtions for (.)n entire field (one ro\v of the 
S(hel11ll t(.)ble). As \vith the Add option, you 111ust 
select the Exit option \vhen you I.)re finished 
dlanging the schenla. \Vhen the Exit menu is 
displayed, choose the Build-ne\N-s(hclna option so 
that file-it! lnc.lkes the necessary changes to the 
databl.lSe files. The Form-design menu l.)ppei:1rs on 
the screen next. Select the Exit option dnd then 
Build-ne\v-fornl. (If vou decide vou do not \vant to 
keep the changes YOll have made, choose Keep­
old-schenld instead, and File-it! vvill restore the old 
schenla.) 

Changing a Field 
The Change option allo\vs you to (hdnge a field 
definition in the schema. You can ch,)nge one part 
of d field or several parts. 



Removing a Field 
You can remove any field from the schema. Use 
the Remove option 'when you decide a field is no 
longer necessary in your da tabase. 

_ Example 2-5 

1: Select the Schema-design menu and llse the 
ARROW keys to move the highlight to the field 
you \vant to delete. Select the Relnove option 
by pressing r. 

File-it! displays the screen sho\vn below, \vith a 
I1lessdge renlinding YOLl that this change \viII 
delete data \vhen you select Build-nevv-schema. 

RErvoVE. LY.u.., No 
De let est h e h i 9 h I I 9 h ted fie I d from the s c h ema . 

Record size 95 
----- Page 1 of 1 ------ chkbook ------------ --- Press CONTROL-W for Help ----

Data Field Name Type Length Index Dupl icates 

'checknum 
ddate 
payee 
amount 
notes 
tax_ded 

_____ ~ __ i!.t~ _______ L __ lru1~.~~"":"" ___ --.J 
Date j Index Yes 
Character 40 
Money 8 
Character dO 
Character 1 

ThiS change will delete data when you select Exit. Build 

2: Select the Yes option fronl the Remove menu. 

File-it! retnoves the field fronl the screen dnd 
returns to the Schelna-design Inenu. 

3: Select Exit. Then select Build-ne\v-schema. (If 
VOll decide vall do not \vant to renlove the 
held, select -Keep-old-schenld instead. File-it! 
restores the schema to the state it \vas in the 
last tinlC YOLl chose Build-ne\v-schel1ld.) 

File-it! displays a screen telling you \vhich 
fields YOLl have deleted. 



Chapter 3 

Entering Data in Your Database 
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Now that you have defined the fields in your 
database, vou can enter data into it. In this 
chapter you \Nilliearn how to enter data into the 
chkbook database you set up in Chapter 2. You 
will also learn how to update (change) a record 
and how to remove one. 

Example 3-1 

This exanlple displays the Data menu for the 
chkbook database. 

1: After choosing the database you \lvant (in this 
case, the chkbook database), select the Data 
option from the Top-level menu. If you have 
been using the Schema-design menu, select 
the Exit option. Then select Build-ne\N-schenla 
from the Exit menu. File-it! inlplelnents your 
SChenl<l as you have defined it before going to 
the Fonn-design nlenu. Select Exit and then 
Build-nevv-fornl. File-it! builds d nevv fonn for 
your da tc1base schelna and displays the Top­
level nlenu. Select the Data option. 

File-it! displays the Data Inenu at the top of 
the screen dnd a fortn for the chkbook 
d,Habase on the lo\ver portion of the screen. 

DATA 'QUQr~ Next PrevIous Add Update Remove Screen Output Exit 
Searches the act Ive database file_ 

----- Page lot 1 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

-- -- - chkbook ---------------- - Press CONTROL-W tor Help 

o I 
00 00 001 

$0 00 

-1-1 



Example 3-2 

This exanlple adds the following sanlple record to 
the database. 

check number: 
date: 
payee: 
dmount: 
notes: 
tax deduction: 

101 
H/6/H3 
Pacific GdS dnd Electric Co. 
S30.39 
[blank] 
[blank] 

1: After selecting the Data 11lenu for the chkbook 
databi.1se (Exanlple 3-1), select the f\dd option. 

File-it! dears anv data froln the fonn on the 
screen and pos(tions the cursor at the left of the 
first field. It puts d 0 in integer fields, 00/00100 
in date fields, and $0.00 in monev fields. As 
Vall enter nUlnbers into these fie"'lds, vou 
~)venvrite these zero values. "' 

ADD ESCAPE adds new data. DEL discards It. ARRON keys move cursor 
Adds new data to the act Ive database t I Ie. 

Field checknum Type Integer 
----- Page 1 ot 1 -. chkbook Press CONTROL W tor Help ----

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

2: 

[cO] [ 
[00 00 OO[ 
[ 
[SO 00 
[ 
[ I 

Enter data in each field, Inaking sure that the 
type of data you enter is appropriate to the 
field. For exanlple, if you enter a letter in an 
integer field, File-it! 'NiB display the 111eSsage 
Error in field. vVhen a field is cOlllplete, press 
RETURN to 1110ve to the next field. You can back 
up \vithin a field using the left ARROW key. 

RETURN alwavs 1110ves the cursor to the next 
field on the screen. \Vhen the cursor is on the 
bottonl field and you press RETURN, File-it! 
cycles it to the top field. 

t"" 
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Editing function 

Delete characters 

Insert characters 

Clear to end 
of field 

Clear all fields 

Move back 

Move forward 

Move up 

Key and explanation 

CONTROL-X erases the character the 
cursor is on. The cursor remains in 
place and characters to the right of it 
shift left to fill in the space that was 
occupied by the deleted character. 

CONTROL-A acts as a toggle switch. 
Press CONTROL-A once to put File-it! 
into Insert mode; press it again to go 
back to the normal editing mode. 
While File-it! is in Insert mode, any 
characters you enter are put in 
immediately to the left of the cursor; 
the characters to the right of the cursor 
are pushed to the right. You can use 
CONTROL-A to insert missing characters 
in a line without reentering the entire 
line. Remember to press CONTROL-A a 
second time when vou are finished 
using the Insert mode. 

CONTROL-D erases any characters 
between the cursor ~nd the end of the 
field. It performs the same function as 
entering a series of SPACEs until the rest 
of the field is filled with SPACES. 

CONTROL-C clears all the fields on the 
screen. Its use is restricted to the 
Query option only. 

The left ARROW key moves the cursor to 
the left without e~asing characters, as 
does the BACKSPACE kev. If vour 
terminal does not have ARROW keys, 
use CONTROL-H. 

The right ARROW key moves the cursor 
to the right without erasing characters. 
If vour terminal does not have ARROW 
ke\:s, use CONTROL-L. Cse the SPACE b,u 
if \'ou vvant to erase characters. 

The UpARROW key moves the cursor 
up to the previous field. If your 
terminal does not have ARROW keys, 
use CONTROL-K. 



check number: 
date: 
payee: 
amount: 
notes: 
tax deduction: 

102 
H/7/H3 
County Water Supply 
523.49 
check for leaks - this bill seems high 
[blank] 

chl'ck numbl'r: 103 
date: H/9 /H3 
payec: 
i.1mount: 

Safewav 
520 . 

nl)tes: cash 
tax deduction: [blankl 

check number: 104 
date: 
payee: 
amount: 
notes: 
tax dt'duction: 

HIlOiH3 
Pavless 
53Y.2H 
included camping supplies 
[blankl 

check number: 105 
da te: H!25iH3 
payee: relephone Co. 
amount: 552.45 
notes: deduct long distance calls 
tax ded uction: y 

check number: 106 
date: H/271~n 

payee: Safevvav 
amount: 520' 
[wtes: G1sh 
tax deduction: [blankl 

check number: 107 
date: qi 1!H3 
payee: Safewav 
amlmnt: 547.52 . 
notes: included Labor Day picnic 
tax deduction: [blank] 

check number: 108 
date: 9/3/83 
payee: CSAA 
amount: 573.93 
notes: this is deductible on business car only 

ti.1X deduction: y 



REMOVE ~ No 
Removes this record from the active database file, 

------ Page 1 of 1 ----- chkbook ------------------- Press CONTROL-W for Help ----

checknum 1108 I 
ddate 109 03'831 
payee [CSAA 
amount 1$73,93 I 
notes Ithls IS deductible on business car onlv I 
tax_ded [vi 

2: If vou vvant to delete the record, select the Yes 
o~~tion. If not, select the No option. 

-+ File-it! displays the Data menu. If you selected 
the Yes option and deleted a record, a Record 
deleted Inessage appears on the bottom of the 
screen. 

Leaving the Data Menu 

When you have finished \vorking \/vith the Data 
menu, select the Exit option. File-it! displays the 
Top-level nlenu. To continue \vith File-it!, select 
the appropriate nlenu iteln (Schenld-design, Form­
design, Report-design, or Utility). To leave File-it! 
and return to the operating system, select the Bye 
option. 
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Chapter 4 

Using Your Database 
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Now that you have built your database and put 
data into it, you can start to make File-it! work for 
you. This chapter explains how to query (ask 
questions of) your database and how to write the 
fornl to an output file or send the form to the 
printer. It uses the chkbook database that was 
created in Chapter 2 for examples and aSSU111eS 
that the data is the same as was entered in 
Chapter 3. 

Query by Example 

File-it! retrieves infonnation fro111 a database using 
a technique called query hy exa1llple. This 
technique clllo\vs you to fill in d File-it! form (the 
saIne form 'lOU llsed to add data to the database) 
"vith an exa-111ple of the \.tvay one or 1110re fields 
look in the rccord(s) you \vant to find. vVhen yOU 

were looking for Terry Green's address, you Pllt 
the ncllue "Green" in the last_name field as an 
example of \vhat you wanted to find. File-it! 
found the record with Green in the last_name 
field. 

The Current List of Records 

A query searches through a database and causes 
File-it! to generate a list of records that satisfies the 
query. This list is called the Currcnt List of 
Rccords, or silnply the Currellt List, clnd can 
contain zero or Inore records. At lnost, it can 
contain all the records in the database. [f no 
records satisfy your query, the Current List \-vill 
contain I':ero records (you "vill see the Inessage 
There are no records satisfying the conditions). File-it! 
111aintains the Current List until you stop using 
the progral1l or perfonn another query. 

As an example of a query and the resulting 
Current List, aSSUl11e that vou clsk File-it! to find 
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You can query your datdb(lse so that File-it! 
generates ~l Current List containing all the records 
in the file by follovving the directions in Example 
..t-2 belo\v. 

You Gln look through the records in the Current 
List, one at <.1 titne, by repeatedly selecting the N"ext 
option. \Vhen you get to the end of the list, File-it! 
display's the nlessage There are no more records in the 
direction you are going. YOll can also viev\' the 
previolls record by selecting the Previous option. 
You will get the sanle nlessage \,vhen you reach the 
beginning of the Current List using the Previous 
option. 

Example 4-2 

1: After selecting the Delta lnenu, select the Query 
option. 

File-it! dears dnv data froln the forn1 on the 
screen and pos(tions the cursor at the left side 
of the firs t field. 

2: rress ESCAPE. 

- File-it! displays the first record in the database 
dnd generates a Current List of all the records. 
The total number of records is displayed at the 
bottonl of the screen. 

DATA aueri Next PrevIous Add UPdate Remove Screen Output EXI t 
Searches the act Ive database f I Ie 

-- P age 1 0 f 1 - - - - - c h k boo k - -- - _. -- - r res S CONTROL -W for Help 

101 ! 
08 06 831 

checknum 
ddate 
payee 
amount 
notes 

Pac I f I C Ga san dEl e c t riC Co 
$30 39 1 

tax _ded 

8 record(s) found 



Performing a Simple Query 

A simple query is one that searches for one value 
in a single field, for exanlple, "find all checks 
written to Safeway." To perfornl a sinlple query, 
select the Query option, enter the value you \vant 
to find in the field vou want to find it in (called the 
Search Fic/d), and press ESCAPE. File-it! will display 
the first record that satisfies the query. If more 
than one record satisfies the query (for example, if 
you wrote nlore than one check to Safeway), 
File-it! puts the records in the Current List and 
displays the number of records that satisfy the 
query at the bottom of the screen. You can select 
the Next and Previous options to look through all 
the records in the Current List. 

If you make a nlistake \vhile you are entering data 
in a Search Field, vou can correct it before vou 
press ESCAPE. To c·orrect an entry error, use the left 
ARROW or BACKSPACE kev to move the cursor back 
over the error and then type the correct entry over 
the incorrect one. If vou \vant to remove the entrv 
altogether, nlove the 'cursor back to the beginning 
of the field and enter enough SPACES to erase all the 
characters you typed. You can also use the editing 
characters discussed in Chapter 3 to edit a Search 
Field. 

Querying Integer Fields 
To search for a record based on the contents of an 
integer Search Field, select the Query option, move 
the cursor to the Search Field, enter the number 
you \vant to search for, and press ESCAPE. This 
procedure is demonstrated below. File-it! \vill 
generate a Current List containing all the records 
\vith the specified nlllnber in the Search Field. If 
you enter ,1n illegal value (for example, if you 
accidentally put a letter in the luiddle of a 
nunlber), File-it! \vill not let you continue until you 
correct it. 
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DATA !QiiiHyj Next PrevIOus Add Update Remove Screen Output EXit 
Searches the act Ive database f I Ie 

- - - - - Page 1 of 1 ----- chkbook ---------------- Press CONTROL-W for Help 

checknum 
ddate 
payee 
amount 
notes 
tax_dod 

105 I 
08 2:' 831 
Telephone Co 
$:'2 -t5 I 
deduct long distance calls 
yl 

1 rCGord(s) found 

The checknum field is an index field that does not 
a11()\.\' duplicates. \Vhen File-it! searches for check 
nun1bcr 105, it 'Nill find onlv one record. It 
genertltes a Current List th'1t contains the one 
record that satisfies the query'. In this case the 
Next and Previous options 'NiH not display 
additional records because there are no other 
records in the Current List. 

Querying Character Fields 
The next exan1ple den10nstrates a query that puts 
several records in the Current List. 

A Word of Caution. vVhen you are perfonning a 
query based on d character field, make certain that 
you enter the iteln you are searching for exactly 
the san1e \vay you did \vhen you put it into the 
database-in the follo\ving cxalnple you Inust use 
an uppercase S follo\ved by t111 lo\verct)se afeway. 
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DATA ~ Next Previous Add Update Remove Screen Output Exit 
Searches the active database file. 

----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL-W for Help 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

[103 I 
[08 09'831 
[Safeway 
[$2000 
[cash 
[ 1 

3 record(s) found 

5: 

-
6: 

Select the Next option (press n) to see the next 
record in the Current List. 

File-it! d.isplays the next record. 

Select the Next option (press n) to see the final 
record in the Current List; then press n again. 

File-it! displays There are no more recordsin the 
direction you are going at the bottom of the screen, 
indicating that there is no next record in the 
Current List. 

DATA Query '.I':o!.u!..L PrevIous Add Update Remove Screen Output Exit 
Shows the next record In the Current List 

----- Page 1 0 f 1 --- - chkbook Press OONTROL-W for Help 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

1107 I 
[09 01 83[ 
[Safeway 
[$47 S2 1 
[Included Labor Day picnic 
[ [ 

There are no more records in the direction you are gOing 

7: Select the Previous option (press p) to display 
the previous record in the Current List. Press p 
again to display the first record in the Current 
List. Press p a third titne to verify that there is 
no previous record in the Current List. 

File-it! displays the nlessage There are no more 
records in the direction you are going indicating that 
there is no previous record in the Current List. 
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..t: Press ESCAPE. 

File-it! adjusts the amount field (it puts in a 
dollar sign, a decinlal point, and hNO zeros for 
the cents) and displays the first record that 
contains 520.0() in the amount field. You can 
view the other record in the Current List bv 
selecting the Next option. -

DATA' cOu.!H,y.: Next PrevIous Add Update Remove Screen Output EXit 
Searches the act Ive database file. 

----- Page 1 of 1 chkboOk Press CONTROL-W for Help 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

1103 1 
108 09 831 
ISafeway 
152000 
leash 
1 1 

2 record(s) found 

Querying Date Fields 
You must enter c1 date (lS three nU111bers separated 
by periods (8.25.83), SPACES (8 25 83), or slashes 
(8/25/83). File-it! \vill display an error 111essage if 
any of the numbers is out of range (rnonth greater 
than 12 or day greater than the number of days in 
the month) or if there are not three numbers. As 
\vith money search values, File-it! \vill adjust the 
date field as soon as you press ESCAPE. 

63 



DATA ~ Next Previous Add Update Remove Screen Output Exit 
Searches the act ive database file. 

----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL-W for Help 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

1105 1 
10825831 
ITelephone Co. 
1$52.45 1 
Ideduct long distance calls 
1 y I 

1 record(s) found 

Using Relational Operators 

There are six relational operators. They are called 
relatiollal because they describe relationships 
between a search value and the data in a field (for 
example, all checks \vritten for 11lore tlU11l $20.00). 

Relational 
operator 

< 
<= 

<> 
>= 
> 

Meaning 

less than 
less than or equal to 
equal to 
not equal to 
greater than or equal to 
grea ter than 

You have already used one of the relational 
operators withollt actually specifying it. vVhen you 
queried the database searching for check nU111ber 
105, you implied an equal-to relationship. You can 
perform the same search by entering = 105 in the 
checknum field during a query. Try it. (Normally, 
there is no reason to ty'pe the equal sign. ) You can 
repliKe the equal sign vvith any of the relational 
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The example above does not include check number 
104 in the Current List-to include it, use the 
greater-than-or-equal-to operator (> = 104). 

Querying Character Fields 
When your query is based on a character field, 
greater-than means later in the alphabet (closer to 
z); less-than means earlier. In other words, a<z 
and Z>d. 

Any hrwcrcasc character is greater than any 
UPPERCASE character (a>Z). 

Any llu1Jleral (in a character field) is less than an 
UPPERCASE or hnucrcl1sc letter (9<a and 9< A). 

Characters are evaluated from left to right, 
"dictionary" style. Thus "cobra" is less than 
"cow." 

A Word of Caution. Make sure that vou do not 
have a SPACE between the relational operator and 
the first character in the field. To check for names 
that are alphabetized after Sam, use the cOlnnland 
>Sam not> Sam. If there is a SPACE between the 
operator and the first character, File-it! vvilliook for 
a field that begins with a SPACE, not the character 
you intend. 
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= Example 4-9 

This query searthes for all checks written for $25 
or more. 

1: After selecting the Data option, select the 
Query option. 

-- File-it! clears any data from the form on the 
screen and positions the cursor a t the left of the 
first field. 

2: Use the RETURN key to move the cursor to the 
amount field. 

-- File-it! will position the cursor at the left end of 
the amount field. 

3: Enter the search value (> = 25) and press ESCAPE. 

You do not have to enter a dollar sign and, 
because there are no cents involved, you do 
not need a decinl.al point. 

-- File-it! adjusts the field and displays the first 
record that contains $25.00 or more in the 
amount field. 

Querying Date Fields 
When you use a relational operator to search for a 
date, greater-thall means after and Icss-tlll11l means 
before. 
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4: Press ESCAPE. 

- File-it! relTIOVeS the bottom line when you press 
ESCAPE. File-it! displays the first record that 
contains 08/31183 or earlier in the ddate field. 

Searching for a Range of Values 

Sometinles it is necessary to search for values that 
lie between two values, not just those that are 
greater than or less than a search value. A colon 
(:), called the range operator, allows you to perfornl 
this type of query. It represents all the values 
between and including the values on both sides of 
it. 

Example 4-11 

This query searches for all records with checknum 
fronl 103 through 106. 

1: After selecting the Data option, select the 
Query option. 

- File-it! clears an v da ta from the form on the 
screen and positions the cursor on the first 
field-the checknum field. The cursor is 
already on the Search Field so you do not have 
to move it. 

2: Enter the range of search values (103:106). 

- File-it! moves the cursor to the expanded 
Search Field at the bottom of the screen when 
you run out of room in the original Search 
Field. 
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search a character field using the range opera tor. 
When you enter A:M in a character Search Field, for 
example, File-it! searches for all records that 
contain fields that start with any character from A 
through M, not just those that contain exactly A, 
B, C, ... , M (that is, it will find America, British Isles, 
Canada, and so forth). Remelnber that File-it! does 
not look for uppercase and lowercase letters at the 
same time-it will not find words like another, 
brother, or cable in this search. 

U sing a Wildcard in a Character 
Search 

When you pu t an as terisk (*) in a character Search 
Field, the asterisk represents any group of 
characters. This feature is useful for searching 
through comment fields to find important words. 

Example 4-12 

This query searches for records that contain the 
word deduct anywhere in the notes field. 

1: After selecting the Data option, select the 
Query option. 

- File-it! clears any data from the form on the 
screen and positions the cursor at the left of the 
first field. 

2: Use the RETURN key to move the cursor to the 
notes field. J 

File-it! positions the cursor at the left end of the 
notes field. 
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Performing a Complex Query 

A silllple query looks for specific data in olle field of a 
database (for example, find all records with the 
ddate field less than 8/28/83, or the payee field 
starting vvith a letter between Nand Z, or the 
amount field greater than $25). 

A c0111plex qllery looks for data in more thall olle field 
of a database (for example, find all records with 
the ddate field less than 8/28/83, 1111d the payee field 
starting vvith a letter between Nand Z, alld the 
amount field greater than 525). 

You perfornl a cOlnplex query just as you perform 
d simple query, except that you fill in the data you 
dre looking for in more than one field before you 
press ESCAPE. File-it! then generates a Current List 
that contains only records that satisfy all of the 
components of the complex query. 

=-= Example 4-13 

This example searches the chkbook database for all 
records \vith the ddate field less than 8/28/83, the 
payee field starting \vith a letter bet\veen Nand z, 
and the amount field greater than $25. 

1: After selecting the Data option, select the 
Query option. 

- File-it! dears an v da ta from the fonn on the 
screen and positions the cursor at the left of the 
firs t field. 

2: Use the RETURN key to move the cursor to the 
ddate field and e~ter <8/28/83. Do /lot press 
ESCAPE. 
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The following example shows how to create an 
output file. 

Example 4-14 

This procedure creates an output file for the 
chkbook database. 

1: Use the Query option to generate a Current 
List by entering the range 101 :108 in the 
checknum field. Now the Current List 
contains eight records. Select the Output 
option from the Data menu. Then select the 
Form option. 

- File-it! displays the screen shown below. 

FORM OUTPUT FILE LIST :currtn t - , 1st lOne - page 
Writes the Current List to a lile or the printer in lorm format. 

----- Page 1 at 1 ----- chkbook ---.------------- Press CONTROL-W for Help ----

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

[101 1 
[08 06 831 
I Pac iIi c Ga san dEl e c t ric Co. 
[$30.39 1 
[ 
[ 1 

2: Select the One-page option to write this screen 
page to the output file. Select the Current-list 
option to write the entire Current List to the 
output file_ The next screen is the same, 
whichever option you select. 

- File-it! displays the menu shown below. 

FORM OUTPUT TO ;Fllel Pr inter 
Writes the selected records to a tile In form format 

------ Page 1 at 1 ----- chkbook --.------------- Press CONTROL-W lor Help ----

3: Select the File option. 

- File-it! displays the following screen. 
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== Example 4-15 

1: Select the Output option from the Data Inenu. 
Then select the Form option from the Output 
Type 111enu. 

- File-it! displays the Form Output File List 
menu. 

2: Select the Current-list option if you want to 
print the entire Current List. Select the One­
page option if you only \vant to print the page 
displayed on the screen. 

- File-it! displays the Form Output To menu in 
either case. 

3: Select the Printer option. 

- File-it! tlashes the records on the screen as they 
are sent to the printer, and displays Output 
record number x where x is the number of the 
record being output. Make no entries until all 
records have been sent to the printer and 
File-it! displays the Data menu. 

Leaving the Data Menu 

When you have finished \vorking \vith the Data 
menu, select the Exit option. File-it! displays the 
Top-level menu. To continue vvith File-it!, select 
the appropriate nlenu item (Schenld-design, Form­
design, Report-design, or Utility). To leave File-it! 
and return to the operating systeln, select the Bye 
option. 
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Chapter 5 

Designing a Form 
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So far you have learned to use two important 
parts of File-it!, the Data and Schema-design 
menus. 

Chapters 1, 2, and 4 discussed using the Data 
menu and selecting the Data lTIenU from the Top­
level nlenu whenever vou want to work \vith the 
data in your database .. The options in the Data 
men u allow you to 

• Put data in vour database 

• RelTIOVe data from vour database 

• Search the database for particular pieces of 
data 

• Prepare a printable output file containing only 
the data you specify 

Chapter 3 discussed using the Schema-design 
menu and selecting Schema-design from the Top­
level menu whenever vou want to work \vith the 
structure of your datab~se. The options in the 
Schema-design menu allow you to 

• Define a database file by specifying the 
attributes (naITIe, data type, etc.) of each field 
in a record 

• Change the definition of the database file by 
changing one or more field attributes in a 
record 

• Change the definition of the database file by 
renl0ving all the attributes of a field in a 
record 

• Build a database file 

The options in the SchelTId-design lTIenU all 
concern data definition and data organization. 
You never enter, renlove, change, or even view 
data in any of the Schenla-design options. Instead 
you set up a format (schema) to interpret and 
store the data vou enter \vith the various Data 
options. 
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database. 

• Then use Form-design to design how you 
want the form or data to look. 

• Then use Data to enter, search for, and 
remove data. 

When you are using File-it! and you want to make 
changes: 

• Use Schema-design to change the kind of data 
you store (data types, indexes, length of 
character fields) 

• Use Form-design to change the way the form 
or data looks or to control data input 

• Use Data to change the data without changing 
the database design or the form design 

The changes you make in Schema-design affect 
both Data and Form-design. After you change the 
database file definition in Schelna-design, you 
have to build a new form in Form-design to 
ensure that the form is compatible with the 
schemel. 

The changes you Inake in Form-design can affect 
the \-vay the fornl looks in Data as well as how 
you en"'ter and remove data, query the database, 
and update the database in Data. 

The changes you make in Data do not affect 
Schema-design or Fornl-design because Data 
controls data only, not ho\v it is defined or how it 
is presented. "' 

A Schema-design screen and c1 Form-design screen 
are shown belo\v. The Schema-design screen 
shows the database definition of a record in the 
chkbook database. The Form-design screen 
shows how the form looks when it is displayed in 
Form-design. It is a default form produced by 
selecting the Exit and Build options in Form­
design; none at the other options in Form-design 
have been used. 
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with Form-design and Data. But tax_ded still 
appears on the database schema when you use the 
Schema-design nlenu and on the third line of the 
screen when the cursor is inside the field brackets 
in Form-design and Data. The data field name has 
not changed-you have only given it a ne",' label 
for your convenience. 

When you add data to the database using the Data 
menu Add option, the screen looks like the one 
below. 

ADD: ESCAPE adds new dala. DEL discards i I. ARRON keys move cursor. 
Adds new dala 10 Ihe active dalabase Ii Ie. 

Field: lax_ded Type· characler 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL~ lor Help ----

Check # 1109 Da I e I 09 .' 0 3 ! 83 I 

Payee IFi rst Federal Savings 

Amounl 1$75.00 

Tax Deducl ible? 101 

Conments 

The form you see when you are working with the 
Data menu alvvays looks like the fornl you created 
with Form-design. 

Using the Form-design Menu 

As with the Schema-design menu, you use the 
various options of the Form-design menu to set up 
the form the way vou want it. When vou are 
finished with vou~ modifications, select the Exit 
option. File-it! displays the Exit lnenu. Select 
Build-new-form when you \vant the changes to the 
form to become permanent. Select Keep-old-form 
when you want File-it! to ignore the changes you 
have made in this session. Both Exit options 
return you to the Top-level menu. 
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Adding Blank Lines and Pages 

The Add option of the Form-design menu allows 
you to add a blank line or page to the form. Add a 
blank line to divide one group of fields from 
another-perhaps to separate numeric data from 
character data or to isolate a particularly important 
field. Add a blank page to have room to spread 
out the infornlation on your form-intersperse 
field and text lines or add blank lines. You can 
also add a page to put part of your form on the 
second page for more convenient handling. (See 
Example 5-14 for information on moving fields, 
lines, and words.) 

After you select the Add option, File-it! displays 
the Add menu. The Add menu allows vou to 
select whether you want to add a line or a page to 
the form. The following examples explain how to 
use the Add option. (Examples 5-12 and 5-13 
explain how to use the Remove option to delete a 
line or a page thdt does not contain display fields.) 

Example 5-2 

This procedure adds a blank line to the form. 

1: After selecting the Form-design menu from the 
Top-level menu, select the Add option. Use 
the ARROW keys to move the cursor to the line 
be/v'w where you want to put the blank line. 

-. File-it! displays the Add menu as shown 
below. 
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Example 5-3 

This procedure adds a blank page to the form. 

1: After selecting the Form-design menu from the 
Top-level menu, locate the page you want (if 
you have more than one page) by pressing the 
s key (for the Screen option) until you reach the 
page in question. Select the Add option. 

- File-it! displays the Add menu. 

2: Select the Page option from the Add menu. 

- File-it! displays the Add Page menu shown 
belo\v. 

ADD PAGE' IAIIi1J Be to re 
Adds a blank page after this page 

----- Page 1 of 1 ----- chkbook ----------------- Press OONTROL~ for Help ----

3: Select the Before or After option depending on 
whether you \vant File-it! to put the blank page 
before or after the page that is displayed on the 
screen. (If you decide you do not want a new 
page, press DEL to go back to the Form-design 
menu.) 

- File-it! inserts the blank page and then displays 
it. The page counter on the fourth line dlways 
indicates what page File-it! is displaying. 
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Changing the Width of a Display Field 
File-it! changes the display width of a field by 
moving the right side of the field while leaving the 
left side stationary. (You can move the left side, 
together with the en tire field, by using the Move 
option-see Example 5-14.) 

You cannot change the width of a display field 
containing date, edate, or ydate data (see 
Appendix A). You cannot change the width of a 
display field containing character data, but you can 
rearrange the display field so that the same 
number of characters appear on more than one 
line. 

Example 5-4 

This procedure changes the width of a display 
field that does not contain date, edate, ydate, or 
character data. 

1: Use the ARROW keys to move the cursor inside 
the brackets of the display field whose width 
you want to change. Select the Change option 
from the Form-design menu. 

-+ File-it! displays the Change menu. 

2: Select the Width option. 

-+ File-it! displays the Change Width screen with 
the data field name and the data type of the 
display field at the top of the page. 

3: Use the left ARROW key to make the display field 
smaller and the righ t ARROW key to make it 
larger. 

-+ File-it! will display a message at the bottom of 
the screen if you try to make the field too big or 
too small, or if you try to change the width of a 
type character, date, edate, or ydate display 
field. 
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2: Use the ARROW keys to move the cursor inside 
the brackets of the character display field you 
want to change. Select Change. Then select 
Width. 

-- File-it! displays the Change Width screen. 

3: Use the left ARROW key to make the field 
smaller. 

-- File-it! automatically puts brackets on the 
second line when you decrease the wid th of 
the firs t line. "' 

4: Press RETURN to set your change. File-it! 
displays the Form-design menu. 

Changing the Default Value of a Display 
Field 
The Default option makes it easy for you to enter 
the sanle value in a field over and over when you 
are adding data. File-it! displays the default value 
you specify for a field each time you start to add a 
new record to the database. You can accept the 
default value by not entering anything in that field 
and pressing RETURN, or you can write over the 
default value by entering a new value in that field. 

Use a default value to save tinle entering data. 
When most of the people in your names database 
live in San Francisco, for example, you can enter 
San Francisco as the default value for the city field. 
Then when you are entering new names, you need 
only press RETURN for the city field, and File-it! will 
automatically insert San Francisco. You can 
override the default by entering other data in the 
city field. 

To make today's date the default value in a date 
field, enter the \lvord today as the default value. 
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Changing the Comment Associated with a 
Display Field 
Use a comment to remind yourself of special data 
entry conditions, such as format, picture, or range 
(see following sections). Make notes about your 
data or your procedures. You can have a comment 
for each field. 

File-it! displays the comment that is associated 
with a display field while you are using the Data 
menu and the cursor is within the field. You can 
move the cursor to the field while you are adding, 
updating, or querying for a record. The comment 
appears at the bottom of the screen. 

Example 5-7 

This procedure enters a comment for a display 
field. 

1: After selecting the Form-design menu, use the 
ARROW keys to position the cursor in the 
appropriate display field. Select the Change 
option and then the Commen t option. 

-- File-it! displays the screen shown below. 

CHANGE COMMENT: Enter the comment for the active data field. 
>>0 

Field: checknum Type integer 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL-W for Help ----

2: If there is a comment already associated with 
the display field, the comment will appear at 
the top of the screen, after the angle brackets. 
If no comment is associated with the field, the 
angle brackets will have SPACES after them. In 
either case, enter the comment you want. 
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Experiment with the Format option to find how 
your tnachine responds to the varying number of 
places to the right of the decimal point. 

In setting a format, also consider what kind of data 
you have in float data fields. Make sure your 
format is big enough for each item you will enter. 
If your format is ##.####### and you enter a 
number such as 22222222.33 in Data, there will not 
be enough spaces for the number in the format. 
File-it! will not be able to format the number and 
you may get an unexpected display. 

If the number you enter overlays the zeros already 
in the field when you are using Data, add a SPACE 

after your number so that File-it! knows where the 
entered number ends and can format it properly. 

Depending on how your computer stores floating 
point numbers, you may not be able to get an exact 
match when you use the Query option to search 
the database for a particular value in a floating 
point field. However, you can use the range 
operator (:) to search the database for a range that 
includes the value you are looking for (for 
example, 22.2:22.4). 

Example 5-8 

This procedure specifies a format for a type float 
display field. 

1: Use the ARROW keys to move the cursor inside 
the brackets of the type Hoat display field 
whose format you want to specify. Select the 
Change option from the Form-design menu. 
Then select the Format option from the Change 
menu. 

-- File-it! displays the screen shown below. 



Example 5-9 

This procedure sets a range of allowable value$Jor 
any display field. 

1: Use the ARROW keys to move the cursor inside 
the brackets of the display field for which you 
want to set low and high limits. Select the 
Change option from the Form-design menu. 
Then select the Range option from the Change 
menu. 

- File-it! displays the screen shown belo'\-\!. 

CHANGE RANGE. En t e r min i mum and ma x i mum val u e s for the act i ve d a t a fie I d 
Sets ranges of allowed values for a data field. 

Field: checknum Type: integer 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL4N for Help 

Adding to an existing list of 0 pairs of values 

Low I imi t . 10 

High I imi t: 1 

2: Enter the low limit and press RETURN. Enter the 
high limit and press RETURN. You may enter 
more than one pair of values as the range for a 
data field. For example, you could enter 1 and 
99 as the first pair, 300 and 700 as the second, 
and 1100 and 1500 as the third. After you enter 
the first pair of values, the message on the 
screen changes to Adding to an existing list of 1 pairs 
of values .. Enter your second pair of values (300 
and 700). The message changes again to Adding 
to an existing list of 2 pairs of values. Enter your 
third pair of values (1100 and 1500). Once 
again, the message changes. When you have 
entered all the pairs of low and high limits you 
want for this field, press DEL. 

- File-it! displays the Form-design menu. 
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literals (that is, if you enter a character other than 
A, X, or #, it aprears on the screen in the position 
you specified every time you use the Add and 
Update options of the Data menu-you cannot 
enter a different character for that position). 

You can specify a picture with character display 
fields only. 

Example 5-10 

This procedure enters a picture for a social security 
number in the employee database. 

1: Use the ARROW keys to move the cursor inside 
the brackets of the character field you want to 
have a picture. Select the Change option from 
the Form-design menu. Then select the Picture 
option from the Change menu. 

- File-it! displays the screen shown below. 

CHANGE PICTURE ,.(J 
Enter picture lor the act ive data I ield 

Field soc_sec Type. character 
----- Page 1 01 1 ----- employee --------------- Press CONTROL-W lor Help ----

2: Enter ###/##1####. This allows three 
numbers, a slash, two numbers, a slash, and 
four nUlubers. 

File-it! displays the picture on the top of the 
screen as you enter it. 

3: Press RETURN to set the picture and return to 
the Form-design menu. (If you make a 
mistake, vou can use the BACKSPACE or left 
ARROW k~y to back up and correct it, or you can 
press DEL to erase the picture and return to the 
Form-design menu.) When you have finished 
your changes for this session, select Exit and 
Build-new-form. 
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N or should you choose the Zero Fill option for a 
character field. 

Use Options to save time entering data, to prevent 
errors, and to specify how your data will look 
when you enter it. 

Use the following procedure to turn on one or 
more options in the field you are working with. 
There is a description of each of the options 
following the example. 

Example 5-11 

This procedure enters Options. 

1: 

-

Use the ARROW keys to move the cursor inside 
the brackets of the display field for which you 
want to set Options. Select Change from the 
Form-design menu. Then select Options from 
the Change menu. 

File-it! displays the following screen. The third 
line of the screen contains information about 
the field you are working with. 

CHANGE OPT IONS· 
Enter Y for Yes. N for No. ESCAPE enters changes. DEL discards changes. 

Field: checknum Type· integer 
----- Page 1 01 1 ----- chkbook ---------------- Press CONTROL~ for Help ----

[INI] VER I FY: 

[N] REQUIRED 

[N] NQUPDATE: 

[N] NOENTRY: 

[N] REVERSE: 

[N] RIGHT JUSTIFY 

[N] ZERO FILL 

[N] UPSH I FT 

[N] [)QM-JSHIFT: 

[N] AUTONEXT: 

Requires data entry twice in this lield 

Requires data entry in this field 

Prevents updates in this field 

Prevents data entry In this field 

Displays thiS Ileid In reverse video 

Displays the data In this fie I d r i gh t jus til i ed 

Displays the data In this fie I d zero f i I led 

Changes the data In t his 1 i e I d to uppercase 

Changes the data In t his 1 i e I d to lowercase 

Goes to next 1 I e I d a 1 t e r the last character is typed 
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Noupdate Option. The Noupdate option 
preven ts changes in a field while you are 
updating. 

Use the Noupdate option when you do not want 
anyone to change data in a field after it has been 
entered. File-it! will not let the cursor stop on a 
data field which has Noupdate specified. You 
cannot alter the da ta unless vou remove the 
Noupdate option. ~ 

Noentry Option. The Noentry option prevents 
data entry in a field. 

Use the Noentry option when you do not want 
anyone to enter data in a field. If you select Add 
in Data, File-it! will not let the cursor stop on a 
Noentry field. You cannot enter data unless you 
remove the Noentry option. However, you can 
change existing data in d Noentry field by using 
the Update option. 

Reverse Option. The Reverse option displays a 
field in reverse video (dark characters on a light 
field). For tern1inals without reverse video 
capability, File-it! puts angle brackets « and» 
around the field. 

Use the Reverse option to make it easy to find a 
particular field on the form. 

Right Justify Option. The Right Justify option 
aligns data with the right margin of a field after 
you press RETURN. 

Use the Right Justify option when you want the 
data in a field lined up against the right bracket. 
You can use it with any data type. 
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but no display fields. After deleting a field in 
Schema-design, for example, use the Remove 
option to delete the data field name from the form. 

(Example 5-2 shows you how to add a blank line; 
Example 5-3 shows you how to add a blank page.) 

Example 5-12 

This procedure removes a line which has no data. 

1: After selecting Form-design, select the Remove 
option. 

- File-it! displays the following screen with the 
highlight on the Line option. 

REt.OVE: [LJJii] Page 
Removes a I ine not containing data I ields. 

----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL~ lor Help ----

2: Use the ARROW keys to position the cursor on 
the line vou wan t to remove. Press RETURN. 

- File-it! removes the line and displays the 
Form-design n1enu. 

The Remove option can delete any page that does 
not contain data fields. 

109 



Example 5-14 

This procedure moves a field. 

1: After selecting the Form-design menu, select 
the Move option. 

- File-it! displays the following screen. 

~VE : IlliIdJ Line Wo r d 
Moves the act Ive data field to a new locat ion. 

----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL-W for Help ----

2: Use the ARROW keys to position the cursor 
inside the brackets of the field you want to 
move. Then select the Field option. 

- File-it! displays the screen shown below and 
temporarily erases the brackets of the field you 
wan t to move. (If you are moving a word or a 
line, File-it! also erases it at this point.) 

~VE FIELD: ARRON keys move cursor. RETURN sets new locat ion. 
Moves the act ive data field to a new locat ion. CONTROL-N for screen 

Field: checknum Type. integer 
----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL~ for Help ----

3: Use the ARROW keys to move the cursor to the 
new field location. If you are moving the field 
to the left edge of the screen or right next to 
another field or word, allow one SPACE to the 
left of the cursor for the temporarily-invisible 
left bracket. Then press RETURN. (If you want 
to move the field to another page, use 
CONTROL-N to find the page. Once on the 
correct page, use the ARROW keys to move the 
cursor. Press RETURN when you are finished.) 

- File-it! displays the Form-design menu with the 
field in its new location on the form. 
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Example 5-15 

This procedure preserves or discards changes you 
have made to the form in this session with Form­
design. 

1: After you have finished working with the form, 
select the Exit option. 

-+ File-it! displays the screen shown below. 

EX IT: lay lid -new- formj Keep-o I d - form 
Builds a new form and returns to the Top-level menu. 

----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL~ for Help ----

2: If you want the changes you have just made to 
be permanent, select Build-new-form. If you 
want to discard the changes you have just 
made, select Keep-old-form. 

-+ File-it! returns you to the Top-level menu. 

Quitting the Form-Design Menu 

To leave the Form-design menu, select the Exit 
option. File-it! will display the Exit menu. If you 
have just been working on form changes and want 
to make them permanent before you leave Form­
design, select Build-new-form. If you have not 
made any changes or do not want to keep the 

. changes you have made, select Keep-old-form. 
Both Exit options return you to the Top-level 
menu. 

To continue using File-it!, select the appropriate 
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Chapter 6 

Designing a Report 
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What Is a Report? 

A report is your data, arranged in a format you 
design, and displayed where you specify; on the 
screen or on pa per . You can also s tore a report in 
an operating system file for future use. A File-it! 
report can sort records and produce subtotals and 
totals. One of the examples in this section shows 
you how to use File-it! to print mailing labels. 

Preparing a report is a two-step process. First you 
must design the report-decide what fields go 
where. Then you can run it and see the results. 

Designing a Report 
Using the File-it! Report-design options, you cal i 
design formats for two kinds of printable reports: 
a column report and a line report. Either report 
can be displayed on screen, written to a file for 
storage or editing, or sent directly to the printer. 

A column report lists fields in columns, with each 
record taking up an entire row. A column report 
based on the chkbook database might look like 
this: 
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provides the following margins. 

Margin Size 
left 5 spaces 
bottom 1 line 
top 1 line 

For a report sent to an output file or the printer, 
File-it! provides the following margins. 

Margin Size 
left 5 spaces 
bottom 3 lines 
top 3 lines 

When you are finished designing the report, the 
Preview option allows you to see what your data 
looks like in your report. Then, if you want, you 
can modify the design of the report. When you 
are satisfied with the design of the report, build 
the report by selecting the Build -new-report option 
from the Column-report or Line-report Exit menu. 
When File-it! builds a report, the report becomes 
the current report. Each database file can have 
one current report at a time. File-it! automatically 
displays the current report for the active file when 
you select the Report-design option. If there is no 
current report, File-it! displays the New Report 
Format menu, which offers a choice of the line and 
column formats. 

Running a Report 
You must run a report by selecting the Output 
option from the Data ll1enu. 

After you design what a report will look like, you 
need to tell File-it! \vhich records to include in the 
report. You can include the entire database in the 
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COLUMN-REPORT: ~ Headings Tit Ie New-report Screen Preview Exi t 
Adds or changes report characteristics for the active field. 

Field: checknum Type: integer 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL~ for Help ----

Name 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

Order Width Sort Total Subtotal 

The Change Option 
The Change option allows you to enter new design 
values in the Column-report format or to change 
existing design values_ Using the Change option, 
you can specify the 

• Field order 
• Field wid th 
• Sort field 
• Subtotal fields 
• Total fields 

After selecting the Change option from the 
Column-report menu, use the ARROW keys to put 
the screen highlight on the item you want to enter 
or change. File-it! displays the appropriate screen 
for the item. Enter a number or select a menu 
option, depending on the screen. Press RETURN to 
enter the new value and display the Column­
report menu again. 

You can also make several en tries before returning 
to the Column-report menu. After you make an 
entry, do NOT press RETURN. Instead, use the 
ARROW keys to move the screen highlight to the 
item you want to work with next. When you 
select a menu option, do NOT enter the first letter 
of the option. Use the SPACE bar to move the menu 
highlight over the option you want. Then use the 
ARROW keys to move the screen highlight to the 
item you want to work with next. 

While the screen highlight is over an item, File-it! 
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Field Default Width 
character the wid th you 

specified in 
Schema-design 

integer 6 
long 11 
tloat, single 11.2 
tloat, double 14.2 
serial 11 
date 8 
edate 8 
ydate 8 
money 15 

You can decrease the width of anv field. You 
cannot increase the width of a ch~racter field 
beyond the size specified in Schema-design. All 
the other data types have a maximum width of 20. 

The notation 11.2 for a single-precision tloating 
point number means that the number has a total 
width of 11 (including one place for the decimal 
point) with 2 places to the right of the decimal 
point. The notation for the double-precision 
t10ating point number follows the same 
convention. The number of places to the right of 
the decimal point cannot exceed the total number 
of p laces in the n umber min us one for the decimal 
point-14.13 is valid; 14.14 is not. 

After selecting the Change option from the 
Column-report menu, use the ARROW keys to 
position the screen highlight over the item you 
want to add or change. Enter a value and press 
RETURN, or use the ARROW keys to move the screen 
highlight to the next item you want to work with. 

Sort. If vou want subtotals and totals, decide 
what field you want to sort on. You can have one 
sort field per report. File-it! calculates subtotals 
each time the value of the sort field changes. The 
chkbook report shown above is sorted on the 
payee field, but you could design a report that 
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The Headings Option 
Your report can include column headings. File-it! 
uses the Data Field Names you entered in 
Schema-design as the column headings. If the 
Data Field Name will not fit in the column width 
you specified for its field, File-it! automatically 
expands the width of the field. 

For example, the chkbook tax_ded field is only one 
character wide. N ormallv, a character field cannot 
be wider than its schema""' specification. However, 
if you use the tax_ded field in a report that calls for 
column headings, File-it! will allow a width of 
seven for it, so that there will be room for tax_ded 
to print at the top of the column. The entries you 
make for the Width column do not change to 
reflect the adjustments File-it! makes for column 
headings. 

The report below has the same Width column 
specifications as the "Check Totals" report shown 
at the beginning of this chapter. All design 
elements are exactly the same except that this 
report has column headings. The spacing between 
the checknum and payee fields is different because 
of the headings. 
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displays the'title after the brackets. You can erase 
an existing title by entering SPACES over it. 

The New-report Option 
The New-report option allows you to erase the 
existing column report format and prepare a new 
report format. When you select the New-report 
option, File-it! displays the New Report Format 
menu. Select the option you want (Column-report 
or Line-report). File-it! displays the appropriate 
n1enu. 

The Screen Option 
The Screen option allows you to look at the next 
screen of fields. You will need to use the option 
only when you have enough fields in a record to 
occupy more than one page in Schema-design. 

After you select the Change option in Column­
report and enter the specifications for the first­
page fields you want to include in your report, 
press RETURN to save those entries and display the 
Column-report menu. Then select the Screen 
option. File-it! displays the next screen page, with 
the Column-report menu at the top. Select the 
Change option and enter the specifications for the 
second-page fields you want to include in your 
report. When the last page of a report is displayed 
on the screen and you select the screen option, 
File-it! displays the first page of the report. 

The Preview Option 
The Preview option allows you to look at a report 
format before you build it. File-it! displays the 
report on the screen, using up to 75 records from 
the active file. The data in the report may not be 
properly sorted-this display just lets you check 
the appearance of the report format. You must 
build the report and then use the Output option of 
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this chapter describes how to use the Data options 
to send your report to the screen, a file, or the 
printer. 

If necessary, use the Utility menu described in 
Chapter 7 to select chkbook as the active file. 
Then use the Query option of the Data menu to 
make sure that your chkbook database includes 
the following records: 

check number: 
date: 
payee: 
amount: 
notes: 
tax deduction: 

check number: 
date: 
payee: 
amount: 
notes: 
tax deduction: 

check number: 
date: 
payee: 
amount: 
notes: 
tax deduction: 

check number: 
date: 
payee: 
amount: 
notes: 
tax deduction: 

101 
8/6/83 
Pacific Gas and Electric Co. 
$30.39 
[blank] 
[blank] 

102 
8/7/83 
County Water Supply 
$23.49 
check for leaks - this bill seems high 
[blank] 

103 
8/9/83 
Safeway 
$20 
cash 
[blank] 

104 
8/10/83 
Payless 
$39.28 
included camping supplies 
[blank] 

check number: 105 
da te: 8/25/83 
payee: Telephone Co. 
amount: $52.45 
notes: deduct long distance calls 
tax deduction: y 

check number: 106 
date: 8/27/83 
payee: Safeway 
amount: $20 
notes: cash 
tax deduction: [blank] 
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- File-it! displays the Change Order screen. 

CHANGE ORDER .... > 
Enter an order number for this field. RETURN sets it. DEL discards it. 

Field: checknum Type: integer 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTROL~ for Help ----

Name 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

Order Width Sort Total Subtotal 

4: Enter 1 after the double angle brackets at the 
top of the screen and press RETURN. 

- File-it! moves 1 to its proper place in the 
column report table, automatically enters the 
default field width of 6 in the Width column, 
and displays the Column-report menu. 

5: Use the ARROW keys to move the screen 
highlight down one line, to the ddate Order 
location. Select the Change option, and enter 3 
after the double angle brackets. This time, do 
not press RETURN. Instead, use the down ARROW 

key to move the screen highligh t down one 
line. 

- File-it! enters 3 in the Order column for ddate 
and 8 in the Width column. 

6: In the same way, enter 2 for the payee field in 
the Order column and 4 for the amount field. 

- File-it! displays the following screen. (The 
entries for amount will not appear on the 
screen until you move the highlight or press 
RETURN.) 
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CHANGE TOTAL: Yes [tiiJ 
Does not calculate a total for this field. 

Field: amount Type: money 
----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL~ for Help ----

Name Order Width Sort Total Subtotal 

10: Select the Yes option by using the SPACE bar to 
move the menu highlight over it. Then use the 
ARROW keys to move the screen highlight over 
the Subtotal column for the amount field. 

- File-it! puts Total in the Total column and 
displays the Change Subtotal menu. 

CHANGE SUBTOTAL· Yes ~ 
Does not calculate a subtotal for this field. 

Field: amount Type: money 
----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL~ for Help ----

Name 

TITLE »0 

Order Width Sort Total Subtotal 

11: Select the Yes option by using the SPACE bar to 
move the menu highlight over it. Press RETURN, 

since all entries for the Change option are 
complete. 

- File-it! enters Subtotal in the Subtotal column 
and displays the Column-report menu again. 

12: Select the Title option. 

- File-it! displays the following screen. 

Enter a report tit Ie. RETURN sets it. DEL discards It. 
Field: amount Type. money 

----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL~ for Help ----

Name Order Width Sort Total Subtotal 

13: Enter Check Totals after the double angle 
brackets a t the top of the screen. Press RETURN. 

- File-it! displays the Column-report menu. 
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LINE-REPORT ~ Tit Ie New-report Screen Preview Ex it 
Adds or changes report characteristics for the active field. 

Field' first_name Type: character 
----- Page 1 of 1 ----- names ------------------ Press CONTROL~ for Help ----

Name Order Width Sort Total Subtotal Separator 

firs t name 
last_name 
addressl 
address2 
cit y 
state 
zip 
phone 

The Change Option 
The Change option allows you to enter new design 
values in the Line-report format or to change 
existing design values. Using the Change option, 
you can specify the 

• Field order 
• Width 
• Sort field 
• Subtotal fields 
• Total fields 
• Field separators 

Select the Change option from the Line-report 
menu. Then use the ARROW keys to put the screen 
highlight on the item you want to enter or change. 
File-it! displays the appropriate screen for the item. 
Enter a number or select a menu item, depending 
on the screen. Press RETURN to enter the new value 
and display the Line-report menu again. 

You can also make several entries before returning 
to the Line-report menu. After you make an entry, 
do NOT press RETURN. Instead, use the ARROW 

keys to move the screen highlight to the itenl you 
want to work with next. When vou select a menu 
option, do NOT enter the first letter of the option. 
Use the SPACE bar to move the menu highlight over 
the option you want. Then use the ARROW keys to 
move the screen highlight to the item you want to 
work with next. 
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Field Default Width 
character the wid th you 

specified in 
Schema-design 

integer 6 
long 11 
float, single 11.2 
float, double 14.2 
serial 11 
date 8 
edate 8 
ydate 8 
money 15 

As in the column report, you can decrease the 
width for any field. You cannot increase the v tdth 
of a character field beyond the size specified iL 
Schema-design. All the other data types have a 
maximum width of 20. 

The notation 11.2 for a single-precision floating 
point number means that the number has a total 
width of 11 (including one place for the decimal 
point) with 2 places to the right of the decimal 
point. The notation for the double-precision 
floating point number follows the same 
convention. The number of places to the right of 
the decimal point cannot exceed the total number 
of places in the number minus one for the decimal 
point-14.13 is valid; 14.14 is not. 

Since File-it! left justifies character fields and strips 
them of trailing blanks, and right justifies numeric 
fields, stripping them of leading blanks, the Width 
option is mainly useful for truncating character 
fields that are too long. 

After selecting the Change option from the Line­
report menu, use the ARROW keys to put the screen 
highlight over the item you want to add or change. 
Enter the value and press RETURN, or use the 
ARROW keys to move the screen highlight to the 
next item you want to work with. 
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Separator. The Separator column allows you to 
specify delimiters between fields in a line report. 

File-it! displays the Separator menu after you select 
the Change option and use the ARROW keys to 
move the highlight over the Separator cohunn. 
You can choose to have from zero to five lines 
separating two fields, or you can select the Other 
option. 

When you enter an order number for a field, 
File-it! enters the default Separator, which is I-line. 
This means that the next field will start on the 
following line. A O-lines Separator means that the 
next field will be on the same line. 

The Other option allows you to enter a string of up 
to 10 characters to separate two fields. When you 
specify a separator string for a field, File-it! 
automatically removes the spaces between all 
fields. You can still separate fields with blank 
lines . Use the Other option when you want to 
prepare a report that can be read by another 
program. 

After selecting the Change option from the Line­
report menu, use the ARROW keys to move the 
screen highlight to the Separator column for the 
field you want to change or enter a Separator for. 
When File-it! displays the Separator menu, enter 
the first character of the option you want; 0 (zero) 
for O-lines, 1 for I-line, 2 for 2-lines, 3 for 3-lines, 4 
for 4-lines, 5 for 5-lines, or 0 (letter "oh") for 
Other. File-it! puts the option you chose in the 
Separator column for this field. You can also use 
the SPACE bar to put the menu highlight over the 
option you want to select and then use the ARROW 
keys to move the screen highlight to the next item 
you want to work with. 
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The Preview Option 
The Preview option for the Line-report menu 
allows you to look at a report format before you 
build it. When you select the Preview option, 
File-it! displays the report on the screen, using up 
to 75 records from the active file. The da ta in the 
report may not be properly sorted-this display 
just lets you check the appearance of the report 
format. You must build the report and then use 
the Output option of the Data menu to see the 
actual report. 

You can adjust column orders, change widths, 
vary the sort, total, and subtotal fields, and change 
the title after you inspect the preview report. For a 
report forma tted to· go to the prin ter, the wid th of 
your printer paper may be different than the width 
of the screen. Horizontal lines may "wrap 
around" when you preview the report on the 
screen. If the report is properly formatted for your 
printer, the lines will not wrap when you output 
the report. 

After you adjust your report format you can use 
the Preview option to check the report format 
again. When you are satisfied with the report, 
select the Exit option. 

The Exit Option 
Like the Schema-design and Form-design Exit 
options, the Line-report Exit option offers two 
choices. 

Select the Build-new-report option when you want 
File-it! to save all the entries or changes you have 
made to the line report format in this session. 
Select the Keep-old-report option when you want 
to discard all entries or changes to the format you 
have made in this session with Line-report. 
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3: Enter 1 after the double angle brackets at the 
top of the screen. Press RETURN. 

- File-it! moves 1 to its proper place in the Line­
report table, automatically enters the default 
field width of 10 in the Width column and the 
default Separator value of 1-line in the Separator 
column, and displays the Line-report menu. 

4: Use the ARROW keys to move the screen 
highlight down one line, to the last_name 
Order location. Select the Change option, and 
enter 2 after the double angle brackets. This 
time, do not press RETURN. Instead, use the 
down ARROW key to move the screen highlight 
down one line. 

- File-it! enters 2 in the Order column for 
last_name, 15 in the Width column, and 1-line 
in the Separator column. 

5: In the same way, enter 3 for addressl, 4 for 
city, 5 for state, and 6 for zip. 

- File-it! puts the numbers you enter in their 
proper places in the Order column as you 
move the screen highlight and automatically 
enters default widths (in the case of character 
fields, the widths specified in the schema) and 
a default Separator value of 1-line for each 
field. The screen looks like the one below. 
(The entries for the zip field will not appear on 
the screen until you move the highlight again.) 

CHANGE ORDER >;ii] 
Enter an order number for this field. RETURN sets it. DEL discards it. 

Field zip Type. character 
----- Page 1 of 1 ----- names ------------------ Press CONTROL-W for Help ----

Name Order Width Sor t Total Subtotal Separator 

first_name 1 10 1 - line 
last_name 2 15 1 - line 
address1 3 30 1 - line 
address2 
cit Y 4 25 1 - line 
state 5 2 1 - line 
zip ~ 
phone 
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SEPARATOR: 0 - lines 1 - line 2 - lines 13 - I I nlll 4 - lines 5 - lines Ot he r 
Writes three I ines alter this field. 

Field: zip Type: character 
----- Page 1 01 1 ----- names ------------------ Press CONTROL4N lor Help ----

Name Order Width Sort Total Subtotal Separator 

Ii rst_name 1 10 0- lines 
last_name 2 15 Sor t 1 - line 
address1 
address2 
city 
state 
zip 
phone 

3 30 

4 25 
5 2 
6 5 

10: Press RETURN since all Change entries are 
complete. 

1 - line 

0- lines 
0- lines 
rr:;:TIiiil 

-+ File-it! displays the Line-report menu, with 3-
lines in the Separator column for zip. 

11: Select the Title option and enter Friends. Press 
RETURN. 

-+ File-it! displays the Line-report menu. 

12: Select the Preview option to view your report. 
Then select the Exit option. When File-it! 
displays the Exit menu, select the Build-new­
report option. 

Now "Friends" is the current report for the names 
file. Whenever you select the Report-design 
option for the names file, File-it! will display the 
Line-report menu with the "Friends" report format 
on the screen. You can use the menu options to 
modify the report, or you can keep it as it is. 

To output the actual report, see the section on 
"Displaying and Printing a Report" in this chapter. 
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101 
102 
103 
104 
106 
107 

105 
108 

The resulting report will look like this: 

Deduct ible and Non-deductible Checks 

08/06/83 Pacific Gas and Electric 
08/07/83 County Water Supply 
08/07/83 Safeway 
08/10/83 Payless 
08/27/83 Safeway 
09/01/83 Safeway 

08/25/83 Telephone Co. 
09/03/83 CSAA 

_ Example 6-3 

y 
y 

$30.39 
$23.49 
$20.00 
$39.28 
$20.00 
$47.52 

$180.68 

$52.45 
$73.93 

$126.38 

$307.06 

1: If necessary, use the options in the Utility 
menu to select chkbook as the active file. Then 
select Report-design from the Top-level menu. 

- File-it! displays the following screen. 

COLUMN-REPORT: ~ Headings Title New-report Screen Preview Exit 
Adds or changes report characteristics for the active field. 

Field: checknum Type: integer 
----- Page 1 of 1 ----- chkbook ---------------- Press OQNTROL4N for Help ----

Name 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

Orde r Width Sort Total Subtotal 

CIJ 6 
3 8 
2 30 Sort 
4 10 Total Subtotal 

2: Use the ARROW keys to put the screen highlight 
on the first item in the Width column. Then 
select the Change option. 

- File-it! displays the Change Width screen, with 
the current width of checknum after the double 
angle brackets. 
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3: Move the screen highlight to the word Sort. 

~ File-it! displays the Change Sort menu. 

4: Select the No option by using the SPACE bar to 
move the highlight over it. Then use the 
ARROW keys to move the screen highligh t down 
to the Sort column of the tax_ded field. Use 
the SPACE bar to select the Yes option. Press 
RETURN. 

~ File-it! erases HSort" from the Sort column for 
the payee field, enters it in the Sort column for 
the tax_ded field, and displays the following 
screen. 

OOLUMN-REPQRT: ~ Headings Ti t Ie New-report Screen Preview Exit 
Adds or changes report character ist ics for the act ive field. 

Field: tax_ded Type: character 
----- Page 1 of 1 ----- chkbook ---------------- Press OONTAOL~ for Help ----

Name 

checknum 
ddate 
payee 
amount 
notes 
tax_ded 

Order Width Sort Total Subtotal 

1 
2 
3 
5 

10 
10 
25 
10 Total Subtotal 

5: Select the Title option and enter Deductible and 
Non-deductible Checks over the old title. (If the 
new title is shorter than the old title, enter 
SPACES over e?<tra characters.) Press RETURN. 

~ File-it! displays the Column-report menu. 

6: Select the Preview option to inspect the report. 
If you are satisfied with the new format, select 
the Exit option from the Column-report menu, 
and then the Build-new-report option from the 
Exit menu. 

If you do not want to keep the new report 
format, select the Keep-old-report option from 
the Exit menu. The next time you select 
Report-design for this file, File-it! will display 
the format for the last report you built. 
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REPORT OUTPUT FILE L 15T . ~e;;t:JfiIl En t ire - f i I e 
Writes the Current List to screen. fi Ie. or printer in report format. 

----- Page 1 of 1 ----- chkbook ----------------- Press CONTROL-W for Help ----

Choose the Current-list option if you want to 
output a selected part of your database. For 
example, if you want only August 1983 checks in 
vour "Deductible and Non-deductible Checks" 
~eport, use the Query option to select for the range 
08/01183:08/31/83 in the ddate field bcforc selecting 
the Output option. Then select the Output option. 
When File-it! displays the Report Output File List 
nlenu, select the Current-list option. File-it! will 
output only those records in the Current List. 

Choose the Entire-file option if you want to output 
all the records in your database. 

Sending the Report to the Screen, a File, 
or the Printer 
Whichever option you choose (Current-list or 
Entire-file), File-it! displays the following menu 
next. 

REPORT OUTPUT TO :~ F i I e P r i n t e r 
Displays the selected records on the screen in report formal. 

----- Page 1 of 1 ----- chkbook ---------------- Press CONTROL-W for Help ----

Choose the Screen option if you want to see your 
report on the screen. This report may contain 
different data than vou sa~v when vou selected the 
Preview option from the COllunn-report or Line­
report menu in Report-design. 

Choose the File option if you \-van t to send your 
report to an operating system file for storage or 
later printing. Choose the Printer option if you 
want to send your report directly to the printer. 

If you select the Screen option, File-it! displays 
Running report ... briet1y on the bottom of the screen. 
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Chapter 7 

Using the Utility Menu 
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The Utility menu (shown below) has five options: 
Database, File, Load, Unload, and Exit. 

UTILITY ~~ Fi Ie Load Unload Exit 
Chooses a different database to work wlth_ 

-------------------------- chkbook ---- ------------- Press CONTROL-W for Help ----

The Database option allows you to choose an 
existing database or create a new one. Chapters 1 
and 2 introduced the Database screen and 
discussed how to select or create a database after 
calling up File-it! from the operating system. 

The File option is similar to the Database option. 
Each database has one or more files. The File 
option allows you to choose an existing file in an 
existing database or create a new file for an 
existing database. 

The Load option copies data from an operating 
svstelTI file to a File-il! database file. The Unload 
o'-ption copies data from a File-it! database file to an 
operating system file. (All File-it! files are 
conlpatible \vith full INFORMIX files-you don't 
need to copy files from File-it! to INFORMIX or 
vice versa-. Refer to Appendix D for details.) 

The Exit option returns to the Top-level menu. 

Selecting and Creating Databases 

Example 1-2 explained how to choose an existing 
database and Exanlple 2-1 explained how to create 
a new database after calling up FiLe-it!. This 
section shows ho\v to work with several different 
databases without leaving File-it!. 

To start using a database other than the one you 
are working with, choose the Utility option from 
the Top-level menu. Then select Database. FiLe-it! 
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FILE »0 

INFORMIX, and you keep related files in one 
database, you can use the join and master-detail 
features of INFORMIX to view records from more 
than one file while you are using INFORMIX. If 
you are using File-it! alone, the File option can 
help you organize your data. You may want to 
have a different file for each year in your chkbook 
database, for example. Or you may want to divide 
your names database into several files. 

The following example shows how to create a new 
file for an existing database. 

__ Example 7-1 

This procedure creates a new file called chkbook2 
for the chkbook database. 

1: Select the Utility option from the Top-level 
menu. Then select the Database option and 
enter chkbook as the name of the database. 

- File-it! displays the Utility menu with the name 
of the active file, chkbook, on the' fourth line of 
the screen. 

2: Select the File option. 

- File-it! displays the following screen. 

Choose fi Ie with ARRON keys or enter new fi lename. Press RETURN. 

----------------------- chkbook ---------------- Press OONTROL4N for Help ----

The following files in the database are available: 

Ichkbook 

2: Enter the name of the new file (chkbook2) after 
the angle brackets. Press RETURN. 

- File-it! displays the Utility menu, with the 
name of the new file (chkbook2) replacing the 
name of the old file on the fourth line of the 
screen. 
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Copying Data from One File-it! File to 
Another 
To move data fronl one File-it! database file to 
another, first unload the data from the source 
File-it! database file to an operating systen1 file and 
then load from the operating systeln file to the 
receiving File-it! database file. 

The two File-it! database files must have the saIne 
schelnas (scHne nUlnber and kind of fields). If the 
database file vou unload contains serial or no­
duplicate index data, make sure the receiving 
File-it! database file contains no data. This \vay, 
there will be no contlict between the uriique serial 
or no-duplicate index data you are copying from 
the source file and existing data in the receiving 
file. 

Under certain conditions vou can use the Load and 
Unload options to "compress" your files. For 
example, if you use the Relnove option in Data to 
delete records from vour chkbook file, File-it! 
renloves the records" but keeps their storage slots 
in the file to receive more records as vou add 
them. If you are not planning to add many 
records, you can use the Unload and Load options 
to conlpress the data in the chkbook file. 

The following example shows how to unload the 
data in the chkbook database file to an operating 
svstem file called outfile and then load the data in 
o.lutfile to the database file you created in Example 
7-1, chkbook2. chkbook2 must have the same 
schenla as chkbook. The schema specifications for 
chkbook are given in Chapter 2. 
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4: Select the File option. Then select chkbook2 as 
your new file. 

-+ File-it! displays the Utility menu with 
chkbook2 on the fourth line of the screen. 

5: Select the Load option. 

-+ File-it! displays the following screen. 

LOAD· iCharacteri Binary 
Reads from a file containing all letters and digits 

----------------------- chkbook2 --------------- Press OONTROL-W for Help ----

6: Select the Binary option since you unloaded to 
outfile using the Binary option. 

-+ File-it! displays the screen shown below. 

LOAD FILENAME .. 1] 
Enter the name of the copy file and then press RETURN. 

------------------------ chkbook2 --------------- Press OONTROL4N for Help ----

7: Enter outfile after the double angle brackets at 
the top of the screen. Press RETURN. 

-+ File-it! displays Loading record x at the bottom of 
the screen as it loads and y records loaded when 
it is finished. After pausing brietly, it displays 
the Utility menu. Now chkbook2 contains the 
same data as chkbook. 

Recovering File-it! Data 
The data for a File-it! database file is stored in an 
operating system file \vith the the extension .dat. 
The data from the names database, for example, is 
stored in the names.dat file. 

If vou have the data file for names but vou do not 
h;ve the other files associated with the"' database 
(names.dbd, names.frm, and names.idx), you can 
create d new database file, such as handles, and 
use the Load option of the Utility Inenu to copy 
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database file that will receive the data has the same 
specifications as the schema for the data you are 
loading. After you build a schelna, build a form. 

Next use the Load option of the Utility menu to 
copy the data from an operating system file (say 
loadin) to a File-it! database file (sav chkbook). 
Select the Character option fronl the Load menu. 
File-it! displays the follovving screen. 

LOAD FIELD DELIMITER -.0 
Enter one character and then press RETURN_ 

------------------------ chkbook -------- --- ----- Press CONTROL-W for Help ----

The field delimiter is the character used to mark 
the boundaries of fields in the foreign file. It may 
be anv character. The character vou enter as the 
field l1elinliter must be identical fa the character 
used as field delimiter in the foreign file. For 
example, suppose load in has records that look like 
the follo\ving: 

110,9115/83,Safewdv,20.00,cash,n, 
1 1 1,9/22/83, Bill Smith,8.35,books,y, 

Because a comma appears after each field, you 
know that load in uses a comma as the field 
delimiter. In response to the Load Field Delimiter 
screen, enter a comma. (If the field delimiter you 
enter is different from the field delimiter in the 
copy file, File-it! displays Cannot read file "Ioadin"--bad 
data format in record 1 and does not load the file.) 

After you enter the field delimiter character, press 
RETURN. When File-it! displays the Load Filename 
screen, enter the name of the file you are copying 
data from (Ioadin). File-it! loads the data file into 
your database file, displays x records loaded, pauses 
briet1y, and returns to the Utility rnenu. 
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Appendix A 

Types of Fields 
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This appendix formally defines all the types of 
fields (data types) available in File-it!. Some of the 
types covered here wer'e introduced in Chapter 2. 
Queries based on any of these types follow the 
format introduced in Chapter 4. 

Type Character 
Character fields can contain any string of 
characters. \tVhen vou define your database in 
Schema-design, you Inust specify the length of a 
character field-anvwhere from 1 to 986 
characters. Howe~er, if a character field is an 
index field, the field length cannot exceed 120. A 
character field occupies one byte in each record for 
each character in its length. The default display 
field length in Form-design and Data is equal to 
the length specified in Schema-design. 

Type Integer 
An integer field can only contain whole numbers 
in the range of - 32,768 to ~ 32,767 inclusive. You 
do not need to specify the length of an integer 
field when vou define vour database in Schema­
design; it h~s a fixed length of two bytes. The 
default display field length in Form-design and 
Data is six. 

Type Long 
A long field can only contain whole numbers in 
the range of - 2,1'-17,'-183,6'-18 to + 2,147,483,647 
inclusive. A long field has a fixed length of four 
bytes. The default display field length in Form­
design and Data is eleven. 
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Type Date 
There are three types of date fields: date, edate, 
and ydate. 

Type 

date 
edate 
ydate 

where: 

How the date is displayed 

mm/dd/yy 
dd/mm/yy (European) 
yy/mm/dd (Year first) 

mm = month (1-12) 
dd = day of the month (1-31) 
yy = year (00-99) 

You can enter dates using slashes, periods, or 
SPACES to separate the three fields (3113/18 or 
3.13.18 or 3 13 18). When you enter data into a 
date field, File-it! checks to see that you enter a 
valid date (in addition to checking for illegal 
characters, it checks to see that you do not put too 
many days in a month or months in a year). A 
date field has a fixed length of four bytes. The 
default display field length in Form-design and 
Da ta is eigh t. 
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Appendix B 

Reserved Words 
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The following list includes all of the File-it! reserved 
words. These words have special meanings to 
File-it! -you cannot use them as field, file, or 
database names. 

A access add after alias all allow allowing 
and ascending ass assign a tt a ttribu te 
attributes audit average avg 

B before begin blanks bottotn by bye 

C call char character clipped comments 
comp composite count 

o database date db default define delete 
descending do dominant double downshift 
duplicates dups 

E eda te else end erase every ex execute 

F field file find first float for format from 
function 

G group 

H header headings help 

I if include index input insert instructions 
int integer intersect Into 

J join joining 

L last left len length let line lineno lines 
load location lock long lookup 

M margin master tnatches lnax min minus 
tnoney 

N next noentry none noprompt not 
noupdate 

o of on optional or output 

P page pageno p.ar~m pa~lse perc~nt perm 
permIssIon perlniSSIons pIpe preVIous 
pritnary print printer prompt public 
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Appendix C 

Summary of Commands 
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HELP: You can obtain assistance any time you are using File-it! by 
pressing CONTROL-W. (Hold down the CONTROL key and press w. 
Then release both keys.) 
SCREEN: Displays the next page of the Help text. 
RESUME: Returns you to what you were doing before you 

called Help. 

DATABASE: (This screen is the first you use when you call File-it!) 
Selects an existing database or enters a new database name. RE­

TURN enters the database name; DEL displays the Top-level menu. 
If the database is new or has only one file, File-it! displays the 
Top-level menu after you press RETURN. If the database has more 
than one file, File-it! displays the File menu after you press RE­

TURN. See the Utility menu for more information on Database 
and File. 

BYE: Ends this session with File-it! and returns to the operating 
system. 

TOP-LEVEL: Chooses any path through the tree of menus (Data, 
Schema-design, Form-design, Report-design, Utility, and Bye). 

DATA: Queries (asks questions of) the database; adds, updates, re­
moves, or outputs data. 

QUERY: Retrieves information from the database. Enter the 
values you are searching for in the appropriate field(s). ARROW 

keys move the cursor. ESCAPE executes the search. DEL dis­
cards the search and returns to the Data menu. 

NEXT: Displays the next record in the Current List (the list of 
records that satisfied the last query). 

PREVIOUS: Displays the previous record in the Current List. 

ADD: Adds a record to the database. Enter the appropriate 
values in the form on the screen. RETURN and ARROW kevs 
move the cursor. ESCAPE adds data; DEL discards the additil;n 
and returns to the Data menu. 

UPDATE: Changes all or part of the displayed record. ESCAPE 

enters change; DEL discards change and returns to the Data 
menu. 

REMOVE: Offers the choice ot removing or not removing the 
displayed record from the database. 
YES: Removes the displayed record from the database. 
NO: Does not remove the displayed record from the database. 

SCREEN: Shows the next page of the form; cycles back to the 
first page after displaying the last page. 
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SCHEMA-DESIGN: Defines a new database; changes the defini­
tion of an existing database; removes a field from or adds a field 
to an existing database. 

ADD: Inserts data field descriptions above the line with the 
highlight. Use it to build a new database and to add a field to 
an existing one. 

ADD NAME: Enters the data field name. RETURN enters the 
name. DEL discards it and returns to the Schema-design 
menu. 

ADD TYPE: Chooses a data type for the data field. Some 
options ask you additional questions that pertain to the 
type of data (see below). All options ask if you want the 
field to be an index field except Serial (which automatical­
ly provides an index and prohibits duplicates). Select 
"Yes" if you want the field to be an index, "No" if you do 
not want it to be an index. All Index Yes options ask if 
you want to allow duplicates. Select Yes to allow dupli­
cates, ~o to prohibit them. 

CHARACTER: Stores any combination of letters, 
numbers, and punctuation. 
ADD LENGTH: Specifies the number of characters that 

will appear in the longest entry in the field. RETURN 

enters the length; DEL goes back one step. 
ADO INDEX: Asks if you want this field to be an in­

dex field. 
YES: Makes this field an index. 

ADO DUPLICATES: Asks if you want to allow 
duplicate values in this field. 
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 

INTEGER: Stores whole numbers in the range -32,768 to 
+32,767. 
ADD INDEX: Asks if you want this field to be an index 

field. 
YES: Makes this field an index. 

ADO DUPLICATES: Asks if vou want to allow du­
plicate values in this field. -
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 
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DATE: Stores dates in the form mmldd/yy. 
ADD INDEX: Asks if you want this field to be an index 

field. 
YES: Makes this field an index. 

ADO DUPLICATES: Asks if you want to allow du­
plicate values in this field. 
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 

EDATE: Stores dates in the form dd/mmlyy. 
ADD INDEX: Asks if you want this field to be an index 

field. 
YES: Makes this field an index. 

ADO DUPLICATES: Asks if vou want to allow du­
plicate values in this field. ./ 
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 

YDATE: Stores dates in the form yy/mmldd. 
ADD INDEX: Asks if you want this field to be an index 

field. 
YES: Makes this field an index. 

ADD DUPLICATES: Asks if you want to allow du­
plicate values in this field. 
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 

MONEY: Stores dollars and cents. 
ADD INDEX: Asks if you want this field to be an index 

field. 
YES: Makes this field an index. 

ADD DUPLICATES: Asks if you want to allow du­
plicate values in this field. 
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 
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SERIAL: Stores sequential numbers starting at the number 
you specify. File-it! automatically increments this number 
each time you add a record to the database. 
CHANGE STARTING NUMBER: Specifies the starting 

number for the serial number. Index is automatically 
provided; duplicates are not permitted. RETURN enters 
the starting number and displays the Schema-design 
menu; DEL returns to the Schema-design menu. 

DATE: Stores dates in the form mm/dd/yy. 

EDATE: Stores dates in the form dd/mm/yy. 

YDATE: Stores dates in the form yy/mm/dd. 

MONEY: Stores dollars and cents. 

CHANGE INDEX: Asks if you want this field to be an index 
field. 
YES: Makes this field an index. 

CHANGE DUPLICATES: Asks if you want to allow du­
plicate values in this field. 
YES: Allows duplicates. 
NO: Does not allow duplicates. 

NO: Does not make this field an index. 

REMOVE: Offers the choice of deleting or not deleting an entire 
field (the whole line containing the highlighted value). 
YES: Deletes the highlighted field from the schema. 
NO: Does not delete the highlighted field. 

SCREEN: Shows the next page of the form; cycles back to the 
first page after displaying the last page. 

EXIT: Leaves the Schema-design menu. 
BUILD-NEW-SCHEMA: Incorporates the additions and 

changes you have just made. Displays the Form-design 
menu. 

KEEP-OLD-SCHEMA: Discards changes made to the schema 
in this session before returning you to the Top-level menu. 
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OPTIONS: Chooses from a list of options. Y selects option, N 
ignores option. ESCAPE enters the option list; DEL discards 
the option list and returns to the Form-design menu. 

VERIFY: Requires you to enter data twice. Entries must 
match exactly to proceed. 

REQUIRED: Requires you to enter data in this field. 
NOUPDATE: Does not allow' the already entered value in 

this field to be changed with the Data Update option. 
NOENTRY: Does not allow anything to be entered into this 

field. (Existing entries may be changed during Update.) 
REVERSE: Displays this field in reverse video. 
RIGHT JUSTIFY: Automatically right justifies an entry in 

this field. 
ZERO FILL: Pads the field with zeros instead of SPACES. 

UPSHIFT: Automatically makes an entry in this field upper­
case. 

DOWNSHIFT: Automatically makes an entry in this field 
lowercase. 

AUTONEXT: Automatically moves the cursor to th~ next 
field when this field is full. 

REMOVE: Deletes a non-data line or page from the form. DEL 

returns to the Form-design menu. 
LINE: Deletes the non-data line the cursor is on. 
PAGE: Deletes the non-data page displayed on the screen. 

MOVE: Repositions a field, line, or word on the screen. ARROW 

keys move cursor. RETURN sets the change; DEL discards it and 
returns to the Form-design menu. 
MOVE FIELD: Moves the active data field to a new location. 
MOVE LINE: Moves the active line to a new location. 
MOVE WORD: Moves the active word to a new location. 

SCREEN: Shows the next page of the form; cycles back to the 
first page after displaying the last page. 

EXIT: Leaves the Form-design menu. 
BUILD-NEW-FORM: Incorporates the additions and changes 

you have just made. Returns you to the Top-level menu. 
KEEP-OLD-FORM: Discards changes made to the form in this 

session before returning you to the Top-level menu. 
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EXIT: Leaves Column-report and returns to the Top-level 
menu. 
BUILD-NEW-REPORT: Incorporates the additions and 

changes you have just made to the column report format 
and makes this report the current report for this file. 

KEEP-OLD-REPORT: Discards changes made to the column 
report format in this session. Retains former report as the 
current report for this database file. 

LINE-REPORT: Displays the existing line report or designs a 
new one. 

CHANGE: Changes the highlighted existing report specifica­
tions or enters new ones. Use the ARROW keys to move the 
highlight to the appropriate column for the field you want 
to change. RETURN adds or changes entries; DEL returns to the 
Line-report menu. 
ORDER: Enters or changes order numbers for report fields. 

RETURN enters the number; DEL returns to the Line-report 
menu. 

WIDTH: Changes widths for report fields. RETURN enters 
the number; DEL returns to the Line-report menu. 

SORT: Enters or changes the sort field for this report. 
YES: Makes this field the sort field. 
NO: Removes sort from this field. 

TOTAL: Calculates or does not calculate a total for this 
numeric field (not suitable for character, date, edate, 
ydate, or serial fields). 
YES: Calculates a total for this field. 
NO: Does not calculate a total for this field. 

SUBTOTAL: Calculates or does not calculate a subtotal for 
this numeric field (not suitable for character, date, edate, 
ydate, or serial fields) each time the sort field changes. 
YES: Calculates a subtotal for this field each time the sort 

field changes. 
NO: Does not calculate a subtotal for this field. 

SEPARATOR: Enters field separators. 
O-LINES: Begins the next field on the same line. 
I-LINE: Begins the next field on the next line. 
2-LINES: Begins the next field after skipping one line. 
3-LINES: Begins the next field after skipping two lines. 
4-LINES: Begins the next field after skipping three lines. 
5-LINES: Begins the next field after skipping four lines. 
OTHER: Selects a string separator. 

OTHER SEPARATOR: Separates this field from the 
next with a string of up to 10 characters. Both fields 
are on the same line. Removes all horizontal spaces 
between fields for this report. RETURN enters string; 
DEL returns to the Separator menu. 

TITLE: Enters or changes the title of this report. RETURN enters 
the title; DEL returns to the Line-report menu. 
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UTILITY: Chooses a database and a file; loads and unloads data. 

DATABASE: Selects an existing database name or enters the 
name of a new database. RETURN enters the name; DEL returns 
you to the Utility menu. If you choose a database with only 
one file or name a new one, you return to the Utility menu. If 
you choose a database with more than one file, you proceed to 
the File screen. 

FILE: Chooses an existing file or names a new file. RETURN 

enters the filename; DEL returns you to the Utility menu. 

LOAD: Copies data from a file into the database file. DEL returns 
you to the Utility menu. 

CHARACTER: Reads from a file containing ASCII data. 
LOAD FIELD DELIMITER: Enters one character ( I is sug­

gested) to delimit character fields. RETURN enters delimiter; 
DEL goes back one step. 
LOAD FILENAME: Enters the name of the file you want 

to copy. RETURN enters the filename; DEL goes back one 
step. 

BINARY: Reads from a file containing binary data. 
LOAD FILENAME: Enters the name of the file you want to 

copy. RETURN enters the filename; DEL goes back one step. 

UNLOAD: Copies data from this database file into another file. 

CHARACTER: Copies ASCII data to a file. 
UNLOAD FIELD DELIMITER: Enters one character ( I is 

suggested) to delimit character fields. RETURN enters del­
imiter; DEL goes back one step. 
UNLOAD FILENAME: Enters the name of the file you 

want to copy to. RETURN enters the filename; DEL goes 
back one step. 

BINARY: Copies to a file containing binary data. 
UNLOAD FILENAME: Enters the name of the file vou want 

to copy to. RETURN enters the filename; DEL goes .!back one 
step. 

EXIT: Returns you to the Top-level menu. 
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Appendix D 

File-it! and INFORMIX 
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You can immediately use all database files created 
by File-it! with INFORMIX versions 3.20 and 
higher. INFORMIX uses the same schema, form, 
and data that File-it! uses. No adjustments or 
modifications are necessary. 

With the exception of database files containing 
composite fields or character fields longer than 986 
characters, you can use all database files created 
by INFORMIX with File-it!. File-it! uses the same 
schema and data that INFORMIX uses. Because 
File-it! does not use the INFORMIX form, you 
have to use the Form-design option in File-it! to 
build a File-it! form. Then vou can use files from 
INFORMIX with the form from File-it!. The form 
you create in File-it! can be identical to the one 
you created for INFORMIX, or it can be different. 

You can use INFORMIX database files containing 
features specific to INFORMIX with File-it!. 
However, if you use an INFORMIX file containing 
features found only in INFORMIX, you cannot 
modify the schema while working with File-it!. 

The table on the following page sun1marizes the 
interaction between database files created in 
INFORMIX and File-it!. 
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Appendix E 

File-it! Filenames 
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A File-it! database file is made up of the following 
operating system files: 

filename.dat 
filename .dbd 
filename. frm 
filename. idx 

data file 
da tabase dictionary file 
form file 
index file 

File-it! automaticallv creates the four files \vhen 
vou define and bui1d a schema and fornl for a 
new database file. 

filename.dat stores the data vou enter in the 
database file. filename.dbd stores the database 
schema specifications. filename.frm stores the 
database form specifications. filename.idx stores 
the database index information. File-it! creates the 
index file whether or not you have indexes in 
your database file. 

In addition, File-it! may have the following two 
files: 

filename.out 
filename. pir 

output file 
report forma t file 

filename.out stores the records vou select for 
output in either form or report tornlat when you 
accept the default output filename. If you assign a 
name of your own to the output file, you will not 
have a filename. out file. filename.pir stores the 
report format specifications. 
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Appendix F 

Specifying a Terminal on a UNIX 
System 
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Because File-it! takes advantage of features that are 
specific to various kinds of terminals, on a UNIX­
based system you will need to know the TernlL~ap 
name of your terminal (the name that tells File-itl 
what kind of terminal you have). This appendix 
tells you how to establish this information in a 
startup file that automatically executes the 
appropriate commands each time you log on. It 
also explains how you can manually give the 
commands each time you log on. 

The operating system file named termcap contains 
a list of tenninals and descriptions of how each 
one operates. Each entry in this file has a nalne; 
one of these names is the name of the Termcap 
entry for your terminal. If you are not sure what 
your Termcap name is, ask your system 
administrator or someone familiar with your 
installation. Then follow the instructions below to 
communicate the Termcap name to File-itl. 

If you are using the Bourne Shell, give the 
following commands to tell the operating system 
the type of terminal you are using before you call 
up File-it!. You can also place these commands in 
the . profile file in your home directory so tha t 
they will execute automatically each time you log 
on. Replace "name" with the name of the 
Termcap name for your terminal. 

$ TERM=name 
$ export TERM 
$ 

If you are using the C Shell, give the following 
commands to t~ll the operating system the type of 
terminal you are using. You can also place these 
commands in the .login file in your home 
directory for autonlatic execution each time you 
log on. Replace "name" with the Termcap name 
for your terminal. 

(7<:; setenv TERM name 
(,7r, 
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.dat extension 161, 197 

.dbd extension 161, 197 

.frm extension 161, 197 

.idx extension 161, 197 

.login file 201 

.out extension 197 

. pir extension 197 

. profile file 201 

Add Line option, Form-design 90 
Add menu, Form-design 89 
Add option, Data 15, 42, 43 
Add option, Form-design 89 
Add option, Schema-design 29, 31 
Add Page menu, Form-design 91 
Add Page option, Form-design 91 
After option, Form-design 91 
ARROW keys 4 
Autonext option, Form-design 108 

BACKSP ACE key 4 
Bar, vertical 164 
Before option, Form-design 91 
Binary option, Utility 162 
Bourne Shell 201 
Build-new-form 34, 35, 36, 88, 90, 94, 96, 102, 103, 113 
Build-new-report, Column-report 128 
Build-new-report, Line-report 141 
Build-new-schema 29, 34, 35, 36, 37 
Bye option, Top-level 114 

C Shell 201 
CANCEL key 4 
Capitalization 14, 42, 142 
CARRIAGE RETURN key 3 
Change Anyway menu, Schema-design 36 
Change Comment screen, Form-design 97 
Change Default screen, Form-design 96 
Change Format screen, Form-design 99 
Change menu, Form-design 92 
Change option, Column-report 121 
Change option, Form-design 92 
Change option, Line-report 135 
Change option, restrictions 92 
Change option, Schema-design 35, 36 
Change Options screen, Form-design 105 
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Data, money 24, 42 
Database name, selecting a 21 
Database option, Utility 155 
Database, chkbook 26, 53 
Database, definition of 5 
Database, demonstration 10 
Database, names 10 
Database, Names 10, 11 
Database, selecting all, 155 
Database, setting up a 21, 26, 156 
Dbd extension 161, 197 
Default option, Form-design 95, 96 
DEL 4 
DEL key 45 
DELETE key 4 
Display field 88 
Downshift option, Form-design 108 
Duplicates 25 

Entire-file option, Data 151 
ESCAPE key 4, 45 
Exit menu, Form-design 113 
Exit option, Column-report 128 
Exit option, Data 44, 79 
Exit option, Fonn-design 34, 35, 36, 88, 90, 94, 96, 

102, 103, 112 
Exit option, Line-report 141 
Exit option, Schema-design 29, 34, 35, 36, 37 
Exit option, Utility 155 
Extensions, filename 161, 197 

Field delimiter 163, 164 
Field, defining a 29 
Field, definition of 22 
File option, Data 151 
File option, Utility 155, 156 
File screen, Utility 157 
Filename extensions 161, 197 
Filenames 161, 197 
Floating point number 98 
Form 9, 10 
Form option, Data 76, 150 
Form Output File List menu, Data 77 
Form Output File menu, Data 78 
Form Output Filename screen, Data 78 
Form Output To Inenu, Data 77 
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One-page option, Data 77 
Options, Form-design 104, 105 
Order option, Column-report 122 
Order option, Line-report 136 
Other option, Line-report 139 
Out extension 197 
Output option, Data 76, 128, 150 
Output Type menu, Data 76, 150 

Picture option, Form-design 102, 103 
Pir extension 197 
Preview option, Column-report 127 
Preview option, Line-report 141 
Preview option, Report-design 119 
Previous option, Data 56, 57 
Printer option, Data 151 
Profile file 201 

Query 11, 12, 14, 17, 53 
Query by example 53 
Query option, Data 48, 150 
Query, character field 59 
Query, complex 75 
Query, date field 63 
Query, definition 7 
Query, integer field 57 
Query, money field 62 
Query, range 71 
Query, relational 66 
Query, simple 57, 75 
Query, wildcard 73 
Quit 4 

Range operator 71, 72 
Range option, Form-design 100, 101 
Record key 162 
Record, definition of 22 
Record, size of 23 
Relational operator, character field 67 
Relational operator, date fields 69 
Relational operator, integer field 66 
Rela tional opera tor, money field 68 
Relational operators 65, 67 
Remove Line option, Form-design 109 
Remove menu, Form-design 109 
Remove menu, Schema-design 37 

209 



Unload Field Delimiter screen, Utility 164 
Unload Filename screen, Utility 160,"' 164 
Unload menu, Utility 164 
Unload option, Utility 155, 158 
Unload screen, Utility 160 
Update option, Data "'48 
Uppercase 13, 14, 42, 59, 67, 108, 142 
Upshift option, Form-design 108 
Utility menu 155, 157 

Verify option, Form-design 106 
Vertical bar 164 

Width option, character field 94 
Width option, Column-report 122 
Width option, Form-design 93 
Width option, Line-report 136 
Width, default, Column-report 122 
Width, default, Line-report 136 

Zero Fill option, Form-design 108 

211 



Printed in U.S.A. 
PIN 690·16308'()01 

'/ 

[AltO)) 
COMPUTER SVSTEMS,p; 

2641 Orchard Park Way, San Jose, .California 95134 
(4081 946-6700, Telex 470642 Alto UI 

-
.~ 

June 1985 


